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Environmental notices and statements

You must become familiar with the environmental notices and statements.

The following topics describe the environmental notices and statements that are
applicable to this product.

1089CORE

The following comments apply to the IBM® servers that have been designated as
conforming to NEBS (Network Equipment-Building System) GR-1089-CORE.

Power and cabling information for NEBS (Network
Equipment-Building System) GR-1089-CORE

The equipment is suitable for installation in the following:
* Network telecommunications facilities
» Locations where the NEC (National Electrical Code) applies

The intrabuilding ports of this equipment are suitable for connection to intrabuilding
or unexposed wiring or cabling only. The intrabuilding ports of this equipment must
not be metallically connected to the interfaces that connect to the OSP (outside
plant) or its wiring. These interfaces are designed for use as intrabuilding interfaces
only (Type 2 or Type 4 ports as described in GR-1089-CORE) and require isolation
from the exposed OSP cabling. The addition of primary protectors is not sufficient
protection to connect these interfaces metallically to OSP wiring.

Note: All Ethernet cables must be shielded and grounded at both ends.

The ac-powered system does not require the use of an external surge protection
device (SPD).

The dc-powered system employs an isolated DC return (DC-I) design. The DC
battery return terminal shall not be connected to the chassis or frame ground.

Product recycling and disposal

Ensure that you are aware of the materials that must be recycled.

This unit must be recycled or discarded according to applicable local and national
regulations. IBM encourages owners of information technology (IT) equipment to
responsibly recycle their equipment when it is no longer needed. IBM offers a
variety of product return programs and services in several countries to assist
equipment owners in recycling their IT products. Information on IBM product
recycling offerings can be found on IBM’s Internet sites at: jwww.ibm.com/ibm/
[recycle/us/index.shtml| or www.ibm.com/ibm/environment/products/index.shtml.

Esta unidad debe reciclarse o desecharse de acuerdo con lo establecido en la
normativa nacional o local aplicable. IBM recomienda a los propietarios de equipos
de tecnologia de la informacion (TI) que reciclen responsablemente sus equipos
cuando éstos ya no les sean Uutiles. IBM dispone de una serie de programas y
servicios de devolucidn de productos en varios paises, a fin de ayudar a los
propietarios de equipos a reciclar sus productos de Tl. Se puede encontrar
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informacion sobre las ofertas de reciclado de productos de IBM en el sitio web de
IBM: [www.ibm.com/ibm/recycle/us/index.shtml| or [www.ibm.com/ibm/environment/
[products/index.shtml|

Note:

This mark applies only to countries within the European Union (EU) and
Norway.

Appliances are labeled in accordance with European Directive 2002/96/EC
concerning waste electrical and electronic equipment (WEEE). The Directive
determines the framework for the return and recycling of used appliances as
applicable throughout the European Union. This label is applied to various
products to indicate that the product is not to be thrown away, but rather
reclaimed upon end of life per this Directive.

Remargue : Cette marque s'applique uniguement aux pays de I'Union Européenne et a la Norvége.

L'étiquette du systéme respecte la Directive européenne 2002/96/EC en matiére de
Déchets des Equipements Electriques et Electroniques (DEEE), qui détermine les
dispositions de retour et de recyclage applicables aux systémes utilisés & travers ['Union
européenne. Conformément a la directive, ladite étiquette précise que le produit sur lequel
elle est apposée ne doit pas étre jeté mais étre récupéré en fin de vie.

FRED IO VR EIEESLUG/ LTI —TEVWTOABERERET .

ZOREERICIE, BU GEEN R T D BE T ST AR 18 4 2002/96/EC(WEEE) @ 7 LB E ST
WET, ZoRSE, EUREIIEATAENEAEREOERE VY 2 AOFFEED T
ET. 2Tk, EHERCE ORI THERLE 2T AL ER L LA
MbEAHLDIIEY OGRS TV EY,

In accordance with the European WEEE Directive, electrical and electronic
equipment (EEE) is to be collected separately and to be reused, recycled, or
recovered at end of life. Users of EEE with the WEEE marking per Annex IV
of the WEEE Directive, as shown previously, must not dispose of end of life
EEE as unsorted municipal waste, but use the collection framework available
to customers for the return, recycling, and recovery of WEEE. Customer
participation is important to minimize any potential affects of EEE on the
environment and human health due to the potential presence of hazardous
substances in EEE. For proper collection and treatment, contact your local
IBM representative.

Battery return program

This product may contain sealed lead acid, nickel cadmium, nickel metal hydride,
lithium, or lithium ion batteries. Consult your user manual or service manual for
specific battery information. The battery must be recycled or disposed of properly.
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Recycling facilities may not be available in your area. For information on disposal of
batteries outside the United States, contact your local waste disposal facility or go
to the following Web site:

www.ibm.com/ibm/environment/products/index.shtml|

In the United States, IBM has established a return process for reuse, recycling, or
proper disposal of used IBM sealed lead acid, nickel cadmium, nickel metal hydride,
and other battery packs from IBM Equipment. For information on proper disposal of
these batteries, contact IBM at 1-800-426-4333. Please have the IBM part number
listed on the battery available prior to your call.

For Taiwan:

Please recycle batteries

JiEE e E

For the European Union:

Note: This mark applies only to countries within the European Union (EU).

Batteries or packaging for batteries are labeled in accordance with European
Directive 2006/66/EC concerning batteries and accumulators and waste batteries
and accumulators. The Directive determines the framework for the return and
recycling of used batteries and accumulators as applicable throughout the European
Union. This label is applied to various batteries to indicate that the battery is not to
be thrown away, but rather reclaimed upon end of life per this Directive.

Les batteries ou emballages pour batteries sont étiquetés conformément aux
directives européennes 2006/66/EC, norme relative aux batteries et accumulateurs
en usage et aux batteries et accumulateurs usés. Les directives déterminent la
marche a suivre en vigueur dans I'Union Européenne pour le retour et le recyclage
des batteries et accumulateurs usés. Cette étiquette est appliquée sur diverses
batteries pour indiquer que la batterie ne doit pas étre mise au rebut mais plutét
récupérée en fin de cycle de vie selon cette norme.

Environmental notices and statements Vi


http://www.ibm.com/ibm/environment/products/index.shtml

viii

Ny TY—=HDWNENYTI—RADNy 77—, EU FEICHT SREXEFiHS
B4 2006/66/EC DI NILAEONTWEYT, COERE. Ny T)—LEEBM. &
VEENYT)—EBBMICHATISINDTY, COERIE, FRAFANYTI—LEE
MOERE VS AV ILDBFEEDHTNDELDT, U EEITHh=>GERAENET,
COINIF, FRFACG D LEEITHERICR O THEEGREZT ILENHDH &
EHOEHOICBADNYTY—ICBESATVET,

In accordance with the European Directive 2006/66/EC, batteries and accumulators
are labeled to indicate that they are to be collected separately and recycled at end
of life. The label on the battery may also include a chemical symbol for the metal
concerned in the battery (Pb for lead, Hg for mercury and Cd for cadmium). Users
of batteries and accumulators must not dispose of batteries and accumulators as
unsorted municipal waste, but use the collection framework available to customers
for the return, recycling, and treatment of batteries and accumulators. Customer
participation is important to minimize any potential effects of batteries and
accumulators on the environment and human health due to the potential presence
of hazardous substances. For proper collection and treatment, contact your local
IBM representative.

Spain:
This notice is provided in accordance with Royal Decree 106/2008 of Spain: The
retail price of batteries, accumulators and power cells includes the cost of the

environmental management of their waste.

California:

Perchlorate Material - special handling may apply. See [www.dtsc.ca.gov/
lhazardouswaste/perchlorate]

The foregoing notice is provided in accordance with California Code of Regulations
Title 22, Division 4.5, Chapter 33. Best Management Practices for Perchlorate
Materials. This product, part, or both may include a lithium manganese dioxide
battery which contains a perchlorate substance.

Flat panel display

The fluorescent lamp or lamps in the liquid crystal display contain mercury. Dispose
of it as required by local ordinances and regulations.

Monitors and workstations
New Jersey — For information about recycling covered electronic devices in the

state of New Jersey, go to the New Jersey Department of Environmental Protection
web site at www.state.nj.us/dep/dshw/recycle/Electronic_Waste/index.html|

Oregon - For information about recycling covered electronic devices in the state of
Oregon, go to the Oregon Department of Environmental Quality site at
www.deq.state.or.us/lg/electronics.htm)|

Washington - For information about recycling covered electronic devices in the
State of Washington, contact the Washington Department of Ecology at
1-800Recycle or go to the Department of Ecology Web site at [fortress.wa.gov/ecy/|

IBM System Storage SAN Volume Controller: Master Console Guide


http://www.dtsc.ca.gov/hazardouswaste/perchlorate
http://www.dtsc.ca.gov/hazardouswaste/perchlorate
http://www.state.nj.us/dep/dshw/recycle/Electronic_Waste/index.html
http://www.deq.state.or.us/lq/electronics.htm
https://fortress.wa.gov/ecy/recycle/
https://fortress.wa.gov/ecy/recycle/

About this guide

This guide provides an overview of the characteristics and requirements of the
master console, which can be a component of an IBM System Storage™ SAN
Volume Controller system.

For SAN Volume Controller version 4.2.1 and earlier, the master console provides a
single point from which to manage the SAN Volume Controller nodes. Although it
can no longer be purchased, the master console can be upgraded to support
clusters running the latest SAN Volume Controller software.

Who should use this guide?

The intended audience for this guide is the IBM service representative.

This guide should be read by the IBM service representative who is responsible for
the initial installation of the SAN Volume Controller hardware, including the
redundant ac-power switch and the uninterruptible power supply.

After the IBM service representative has installed the SAN Volume Controller
hardware, the customers must use the IBM System Storage SAN Volume Controller
Software Installation and Configuration Guide to install any additional software and
to configure the SAN Volume Controller.

Emphasis

Different typefaces are used in this guide to show emphasis.

The following typefaces are used to show emphasis:

Boldface Text in boldface represents menu items and
command names.

ltalics Text in italics is used to emphasize a word.
In command syntax, it is used for variables
for which you supply actual values, such as
a default directory or the name of a cluster.

Monospace Text in monospace identifies the data or
commands that you type, samples of
command output, examples of program code
or messages from the system, or names of
command flags, parameters, arguments, and
name-value pairs.

SAN Volume Controller library and related publications

A list of other publications that are related to this product are provided to you for
your reference.

The tables in this section list and describe the following publications:

* The publications that make up the library for the IBM System Storage SAN
Volume Controller

» Other IBM publications that relate to the SAN Volume Controller

© Copyright IBM Corp. 2003, 2008 ix



SAN Volume Controller library

The following table lists and describes the publications that make up the SAN
Volume Controller library. Unless otherwise noted, these publications are available
in Adobe® portable document format (PDF) from the following Web site:

www.ibm.com/storage/support/2145|

Volume Controller CIM Agent
Developer’s Guide

concepts of the Common
Information Model (CIM)
environment. Steps about
using the CIM agent object
class instances to complete
basic storage configuration
tasks, establishing new Copy
Services relationships, and
performing CIM agent
maintenance and diagnostic
tasks are included.

Title Description Order number
IBM System Storage SAN This guide introduces the GA32-0551
Volume Controller Planning | SAN Volume Controller and
Guide lists the features you can
order. It also provides
guidelines for planning the
installation and configuration
of the SAN Volume
Controller.
IBM System Storage SAN This guide provides the GC27-2219
Volume Controller Model instructions that the IBM
2145-8A4 Hardware service representative uses
Installation Guide to install the hardware for
SAN Volume Controller
model 2145-8A4.
IBM System Storage SAN This guide provides the GC27-2220
Volume Controller Model instructions that the IBM
2145-8G4 Hardware service representative uses
Installation Guide to install the hardware for
SAN Volume Controller
model 2145-8G4.
IBM System Storage SAN This guide provides SC23-6628
Volume Controller Software | guidelines for configuring
Installation and Configuration | your SAN Volume Controller.
Guide Instructions for backing up
and restoring the cluster
configuration, using and
upgrading the SAN Volume
Controller Console, using the
CLI, upgrading the SAN
Volume Controller software,
and replacing or adding
nodes to a cluster are
included.
IBM System Storage SAN This guide describes the SC23-6665
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Title Description Order number
IBM System Storage SAN This guide describes the SC26-7903
Volume Controller commands that you can use
Command-Line Interface from the SAN Volume
User’s Guide Controller command-line

interface (CLI).
IBM System Storage SAN This guide provides SC26-7905
Volume Controller Host guidelines for attaching the
Attachment Guide SAN Volume Controller to

your host system.
IBM System Storage SAN This guide describes the GC27-2227
Volume Controller features of each SAN Volume
Troubleshooting Guide Controller model, explains

how to use the front panel,

and provides maintenance

analysis procedures to help

you diagnose and solve

problems with the SAN

Volume Controller.
IBM System Storage SAN This guide provides the GC27-2226
Volume Controller Hardware | instructions that the IBM
Maintenance Guide service representative uses

to service the SAN Volume

Controller hardware,

including the removal and

replacement of parts.
IBM System Storage SAN This guide provides the GC27-2221
Volume Controller Models instructions that the IBM
2145-8F2 and 2145-8F4 service representative uses
Hardware Installation Guide |to install the hardware for

SAN Volume Controller

models 2145-8F2 and

2145-8F4.
IBM System Storage SAN This guide provides the GC27-2222
Volume Controller Model instructions that the IBM
2145-4F2 Hardware service representative uses
Installation Guide to install the hardware for

SAN Volume Controller

model 2145-4F2.
IBM System Storage SAN This guide describes how to | GC27-2223
Voolume Controller Master install, maintain, and service
Console Guide the master console.
IBM Systems Safety Notices | This guide contains G229-9054

translated caution and
danger statements. Each
caution and danger
statement in the SAN Volume
Controller documentation has
a number that you can use to
locate the corresponding
statement in your language in
the IBM Systems Safety
Notices document.

About this guide
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Other IBM publications

The following table lists and describes other IBM publications that contain additional

information that is related to the SAN Volume Controller.

You can download IBM eServer™ IBM xSeries® and IBM System x™ publications

from the following Web site:

www.ibm.com/jct01004c/systems/support/|

and DS5300 Installation,
User’s and Maintenance
Guide

install and configure the IBM
System Storage DS5100 and
DS5300.

Title Description Order number
IBM System Storage This guide introduces the IBM | SC23-8824
Productivity Center System Storage Productivity
Introduction and Planning Center hardware and
Guide software.
Read This First: Installing the | This guide describes how to | GI11-8938
IBM System Storage install the IBM System
Productivity Center Storage Productivity Center
hardware.
IBM System Storage This guide describes how to | SC27-2336
Productivity Center User’s configure the IBM System
Guide Storage Productivity Center
software.
IBM System Storage This guide describes the IBM | GC52-1309
Multipath Subsystem Device |System Storage Multipath
Driver User’s Guide Subsystem Device Driver for
IBM System Storage products
and how to use it with the
SAN Volume Controller.
IBM System Storage DS This guide provides GC53-1135
Storage Manager Version information about how to
10.30 Installation and Host plan, install, configure, and
Support Guide work with IBM System
Storage DS™ Storage
Manager.
IBM System Storage DS This guide provides GC53-1136
Storage Manager Version information about setting up,
10.30 Copy Services Guide |installing, configuring, and
working with the three IBM
System Storage DS Storage
Manager premium features
that assist with copy services:
FlashCopy®, VolumeCopy,
and the Enhanced Remote
Mirroring Option.
IBM System Storage This overview describes how |GC53-1137
DS4000/DS5000 Fibre to install the IBM System
Channel and Serial ATA Storage DS4000/DS5000
Intermix Premium Feature Fibre Channel and Serial ATA
Installation Overview Intermix Premium Feature.
IBM System Storage DS5100 | This guide describes how to | GC53-1140
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Title Description Order number
IBM System Storage This guide describes how to | GC53-1141
EXP5000 Storage Expansion |install and configure the IBM
Enclosure Installation, User’s, | System Storage EXP5000
and Maintenance Guide Storage Expansion
Enclosure.
IBM System Storage DS This guide describes the GC52-1275
Storage Manager commands that you can use
Command-line Programming | from the IBM System Storage
Guide DS Storage Manager
command-line interface.
IBM System Storage DS5000 | This guide provides GC53-1134
Quick Start Guide: Quick information about setting up
Reference for the DS5100, and installing the DS5100,
DS5300 and EXP5000 DS5300 and EXP5000.
IBM TotalStorage DS4300 This guide describes how to | GC26-7722
Fibre Channel Storage install and configure the IBM
Subsystem Installation, TotalStorage® DS4300
User’s, and Maintenance Fibre-Channel Storage
Guide Subsystem.
IBM eServer xSeries 306m | This guide describes how to | MIGR-61615
(Types 8849 and 8491) install the IBM eServer
Installation Guide xSeries 306m, which is the
hardware delivered for some
versions of the hardware
master console.
IBM xSeries 306m (Types This guide describes how to | MIGR-61901
8849 and 8491) User’s Guide | use the IBM eServer xSeries
306m, which is the hardware
delivered for some versions
of the hardware master
console.
IBM xSeries 306m (Types This guide can help you MIGR-62594
8849 and 8491) Problem troubleshoot and resolve
Determination and Service problems with the IBM
Guide eServer xSeries 306m, which
is the hardware delivered for
some versions of the
hardware master console.
IBM eServer xSeries 306 This guide describes how to | MIGR-55080
(Type 8836) Installation install the IBM eServer
Guide xSeries 306, which is the
hardware delivered for some
versions of the hardware
master console.
IBM eServer xSeries 306 This guide describes how to | MIGR-55079

(Type 8836) User’s Guide

use the IBM eServer xSeries
306, which is the hardware
delivered for some versions
of the hardware master
console.
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Title Description Order number
IBM eServer xSeries 306 This guide can help you MIGR-54820
(Types 1878, 8489 and 8836) | troubleshoot problems and
Hardware Maintenance maintain the IBM eServer
Manual and Troubleshooting | xSeries 306, which is the
Guide hardware delivered for some

versions of the hardware

master console.
IBM eServer xSeries 305 This guide describes how to | MIGR-44200
(Type 8673) Installation install the IBM eServer
Guide xSeries 305, which is the

hardware delivered for some

versions of the hardware

master console.
IBM eServer xSeries 305 This guide describes how to | MIGR-44199
(Type 8673) User’s Guide use the IBM eServer xSeries

305, which is the hardware

delivered for some versions

of the hardware master

console.
IBM eServer xSeries 305 This guide can help you MIGR-44094
(Type 8673) Hardware troubleshoot problems and
Maintenance Manual and maintain the IBM eServer
Troubleshooting Guide xSeries 305, which is the

hardware delivered for some

versions of the hardware

master console.
IBM TotalStorage 3534 This guide introduces the IBM | GC26-7454

Model FO8 SAN Fibre
Channel Switch User’s Guide

TotalStorage SAN Switch
3534 Model F08.

IBM System x3250 (Types
4364 and 4365) Installation
Guide

This guide describes how to
install the IBM System x3250,
which is the hardware
delivered for some versions
of the hardware master
console.

MIGR-5069761

IBM System x3250 (Types This guide describes how to | MIGR-66373
4364 and 4365) User’s Guide | use the IBM System x3250,
which is the hardware
delivered for some versions
of the hardware master
console.
IBM System x3250 (Types This guide can help you MIGR-66374
4364 and 4365) Problem troubleshoot and resolve
Determination and Service problems with the IBM
Guide System x3250, which is the
hardware delivered for some
versions of the hardware
master console.
IBM TotalStorage SAN This guide introduces the IBM | GC26-7439

Switch 2109 Model F16
User’s Guide

TotalStorage SAN Switch
2109 Model F16.
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Title

Description

Order number

IBM TotalStorage SAN
Switch 2109 Model F32
User’s Guide

This guide introduces the IBM
TotalStorage SAN Switch
2109 Model F32. It also
describes the features of the
switch and tells you where to
find more information about

those features.

GC26-7517

Some related publications are available from the following SAN Volume Controller

support Web site:

www.ibm.com/storage/support/2145|

Related Web sites

The following Web sites provide information about the SAN Volume Controller or
related products or technologies:

Type of information

Web site

SAN Volume Controller
support

www.ibm.com/storage/support/2145|

Technical support for IBM
storage products

www.ibm.com/storage/support/

How to order IBM publications

The IBM Publications Center is a worldwide central repository for IBM product
publications and marketing material.

The IBM Publications Center offers customized search functions to help you find the
publications that you need. Some publications are available for you to view or
download at no charge. You can also order publications. The publications center
displays prices in your local currency. You can access the IBM Publications Center
through the following Web site:

www.ibm.com/shop/publications/ordery|

How to send your comments

Your feedback is important to help us provide the highest quality information. If you
have any comments about this book or any other documentation, you can submit
them in one of the following ways:

e E-mail

Submit your comments electronically to the following e-mail address:

starpubs @us.ibm.com

Be sure to include the name and order number of the book and, if applicable, the
specific location of the text you are commenting on, such as a page number or

table number.
e Mail

Fill out the Readers’ Comments form (RCF) at the back of this book. If the RCF
has been removed, you can address your comments to:
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International Business Machines Corporation
RCF Processing Department

Department 61C

9032 South Rita Road

Tucson, Arizona 85775-4401

U.S.A.
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Chapter 1. Introducing the Master console

For SAN Volume Controller version 4.2.1 and earlier, the master console provides a
single point from which to manage the SAN Volume Controller nodes. The master
console could be purchased as a hardware product option (which includes the
master console preinstalled software) or as a software-only option. Although it can
no longer be purchased, the master console can be upgraded to support clusters
running the latest SAN Volume Controller software.

Beginning with SAN Volume Controller version 4.3.0, the IBM System Storage
Productivity Center (SSPC) is an integrated hardware and software solution that
provides a single point of entry for managing SAN Volume Controller clusters, IBM
System Storage DS8000 systems, and other components of your data storage
infrastructure. For more information on SSPC, see the IBM System Storage
Productivity Center Introduction and Planning Guide.

The two master console options are the same in function and software. However,
the planning, installation, and configuration processes are slightly different:

Master console hardware option
The manufacturing plant installs the software on the hardware using the
default settings. After the IBM service representative installs the hardware
option, you must configure and customize the default factory settings.

Master console software-only option
You must provide your own hardware and perform both the installation and
configuration processes.

The master console provides you with the following functions:
» A platform on which the subsystem configuration tools can be run

» A platform for remote service, which allows the desktop to be shared with remote
IBM service personnel if assistance is required to resolve complex problems

» Access to the following components:
— SAN Volume Controller Console, which is a graphical user interface
application, through a Web browser

— SAN Volume Controller command-line interface, through a Secure Shell (SSH)
session

The master console can support up to two SAN Volume Controller clusters.
Although multiple master console servers can access a single cluster, you cannot
concurrently perform configuration and service tasks if multiple servers are
accessing one cluster.

Master console hardware option components

Your master console software was preinstalled when you ordered the master
console hardware option with your SAN Volume Controller.

The following components are included with the master console hardware option:
* 19-inch 1U rack-mounted IBM eServer xSeries server
* 19-inch 1U flat panel monitor and keyboard
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Attention: If more than one power distribution bus is available, the two power
connectors, one supplying the master console server and the other supplying the
master console monitor, must be connected to the same power distribution bus.

The following software is preinstalled on the system:
+  Microsoft® Windows® 2003 Standard Server Edition with the latest service pack
* PuUTTY, a client for Telnet and Secure Shell (SSH) protocol communications
— Putty.exe, the client software
— Puttygen.exe, a utility for generating encryption keys
— Plink.exe, the command-line interface to the PuTTY client software
* SAN Volume Controller Console
* Adobe Reader

The following Web site provides the current list of supported software versions:

www.ibm.com/storage/support/2145|

After the master console hardware is installed, the customer must configure the
software to meet their requirements.

Master console software components

The master console feature is a collection of different software components.

The master console includes the following software components:
* SAN Volume Controller Console and CIM agent
* PUTTY (SSH client software)

Note: Beginning with SAN Volume Controller version 4.3.1, a second CIM object
manager (CIMOM) is also included with the SAN Volume Controller cluster.
This CIMOM is intended for use by other storage management applications,
such as IBM TotalStorage Productivity Center (TPC), which is installed on
the same server as IBM System Storage Productivity Center. The SAN
Volume Controller Console that is installed on the master console server
continues to use the CIMOM on the master console server and an SSH
connection to communicate with SAN Volume Controller.

Preparing your master console hardware option environment

2

If the master console hardware option is included with the SAN Volume Controller,
ensure that your physical site meets the installation requirements for the master
console hardware and the console monitor kit.

The following tables provide the physical characteristics and the environmental
requirements for the master console hardware option:

Server dimensions and weight

Ensure that space is available in a rack that is capable of supporting the master
console.
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Height Width Depth Maximum Weight
44 mm 480 mm 426 mm 12.7 kg
(1.7 in.) (18.9 in.) (16.8 in.) (28 Ib)

Master console kit dimensions and weight

Ensure that space is also available in the rack for the master console Kkit.

Height Width Depth Maximum Weight
40 mm 480 mm 530 mm 17.0 kg
(1.6 in.) (18.9 in.) (20.9 in.) (37.0 Ib)

Server ac and input-voltage requirements

Ensure that your environment meets the following ac power and voltage

requirements:

Power Supply

Electrical Input

203 watt (110 or 220 V ac auto-sensing)

Sine-wave input (47-63 Hz) required
Input voltage low range:
Minimum: 100 V ac
Maximum: 127 V ac
Input voltage high range:
Minimum: 200 V ac
Maximum: 240 V ac
Input kilovolt-amperes (kVA),
approximately:
Minimum: 0.0870 kVA
Maximum: 0.150 kVA

Server environmental requirements

Ensure that your environment falls within the following ranges:

Environment Temperature Altitude Relative Humidity
Server On 10° to 35°C 0 to 914 m 8% to 80%
(50°F to 95°F) (2998.0 ft)
Server Off -40°C to 60°C Maximum: 8% to 80%
(-104°F to 140°F) 2133 m
(6998.0 ft)

Server heat output

Approximate heat output in British thermal units (Btu) per hour:
* Minimum configuration: 87 watts (297 Btu)
* Maximum configuration: 150 watts (512 Btu)

Prerequisites for the software master console

Before you install the software master console, ensure that you have the
prerequisite hardware and software.

Chapter 1. Introducing the Master console
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Location requirements

The master console must be in the same room and within 50 feet of the SAN
Volume Controller nodes.

Hardware prerequisites

The master console software can be installed on a rack-mounted,
high-performance, highly-reliable Intel® server (such as the IBM eServer xSeries
3250 or equivalent) with the following options:

One Intel Pentium® dual core processor, minimum 2.1 GHz
Minimum of 4 GB of system memory

Two IDE hard disk drives, minimum 160 GB each. During installation of the
master console software, you will mirror these drives.

One CD drive
One Gigabit port for an Ethernet connection (fiber or copper)
One keyboard, such as the Space Saver keyboard or equivalent

One monitor, such as Netbay 1U Flat Panel Monitor Console kit without keyboard
or equivalent

One mouse or equivalent pointing device

Example hardware configuration

An example hardware configuration might consist of the following components:

IBM xSeries 3250 server (1U)

Intel Xeon 3.0 GHz processor

4 GB memory DIMM (256 MB comes with base unit)

Two 160 GB IDE hard disk drives (one comes with base unit)
One Gigabit 10/100/1000 Copper Ethernet port on planar
NetBay 1U Flat Panel Monitor Console Kit with US keyboard

Software prerequisites

The software version of the master console requires that you obtain the following
software:

Operating system
— The software version of the master console requires that one of the following
operating systems is provided on your hardware platform:
- Microsoft Windows Server 2003 Enterprise Edition
- Microsoft Windows Server 2003 Standard Edition
- Microsoft Windows 2000 Server 5.00.2195.

Note: The master console hardware option is shipped with Microsoft Windows
Server 2003, Standard Edition pre-installed.

Microsoft Windows Internet Explorer version 6 with Service Pack 1 or later
You can download Internet Explorer version 7 from the following Web site:
[www.microsoft.com/windows/downloads/ie/getitnow.mspx/|

You can download Internet Explorer version 6 Service Pack 1 from the following
Web site:

[www.microsoft.com/windows/ie/ie6/downloads/
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* Antivirus software (not required but necessary to ensure protection of your
computer).

The following Web site provides the current list of supported software versions:

www.ibm.com/storage/support/2145|
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Chapter 2. Installing the master console

You must install the master console option that is included with your SAN Volume
Controller system.

Installing the master console hardware

If your system includes the master console hardware product option, you must
install it and perform initial hardware configuration for it.

Before you begin the installation, ensure that you have completed the following
tasks:

» Important: Review and complete all of the safety checks that are detailed in the
documentation for the master console IBM eServer xSeries hardware, the
keyboard, and the display.

* Ensure that you have all the customer-completed information that you need,
including the configuration data table, hardware location chart, and the cable
connection table, which are provided at|www.ibm.com/storage/support/2145| The
IBM System Storage SAN Volume Controller Planning Guide provides guidelines
for completing these tables and charts.

If you experience a problem with your master console, use the 2145 machine type
and the serial number of the SAN Volume Controller node that was installed with
the master console to open a hardware problem.

Perform the following steps to install the master console hardware option:

Note: Do not install the pull-out monitor and keyboard of the master console
directly below a SAN Volume Controller node. The front panel of the node
protrudes beyond the front of the rack and overlaps part of the monitor,
which prevents you from being able to open it.

1. Install the master console hardware in the rack, following the hardware
installation instructions that are provided by your xSeries Installation Guide and
by the instructions that are provided with the mounting rails.

If there are any devices directly above and below the master console, it might
be very difficult to reach in and connect the cables to the back of the server
after it is placed in the rack. If that is the only available slot, connect the
keyboard, mouse, monitor, and Ethernet cables at the back of the master
console before you install it in the rack. Leave the other end of the Ethernet
cable disconnected from the network until you are directed to connect it.

Important: Do not follow any software installation procedures in the xSeries
Installation Guide.

2. Ensure that no cables are connected to the Ethernet ports.
3. Turn on the master console.
a. Type administrator in the User ID field.

b. Type passwOrd in the password field; this password applies to all required
password fields. The master console continues to start.

Note: This process can take several minutes before all services are started
and operations are completely responsive.
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c. Click OK if you receive any messages that a network interface card port is
offline.

4. Check that the reference identification tag is securely fastened to the front panel
of the master console. The tag indicates the machine type 2145 and the serial
number of the SAN Volume Controller node that is being installed with the
master console.

5. Connect the master console to the Ethernet port that is designated in the Cable
connection table.

Installing antivirus software on the master console

To protect your workstations and your enterprise, install the latest patches for your
Windows operating system and the latest levels of your antivirus software on the
master console.

If the master console is either connected to your local area network or you have
enabled remote support, you must install the latest levels of the antivirus software
that your enterprise uses.

Installing the master console software

If you purchased the software-only master console option, you must install the
master console software on your own hardware before you can configure and use
the SAN Volume Controller. If you have the purchased the master console hardware
option and the IBM service representative has finished installing it, you can skip the
master console software installation instructions and start configuring the master
console.

Before you install the master console software, you must ensure that you have met
all the prerequisites for installing the software as provided by the IBM System
Storage SAN Volume Controller Planning Guide.

In addition, view the release notes for the master console software on the following
IBM support Web site for the latest information:

www.ibm.com/storage/support/2145|

You can use the installation wizard to help you install the master console software
components instead of installing each component individually.

The following tasks are involved in the master console software installation process:
* Task 1: Install the master console software by using the installation wizard.
* Task 2: Mirror the boot drive.

Important: Other than antivirus software, ensure that the master console software
is the only type of software that is installed on the hardware that you
are using for the master console.

Using the master console installation wizard

8

You use the master console installation wizard to install all the master console
components.

Before you install the master console software, ensure that your system meets the
requirements that are provided in the IBM System Storage SAN Volume Controller
Planning Guide.
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During the installation, the wizard installs the following master console components:
* SAN Volume Controller Console and CIM agent

PuTTY

Perform the following steps to install the master console software:

1.

Log on as a local administrator (for example, as the Administrator user) on the
system where you want to install the master console software.

Insert the master console CD into the CD drive.
Click Start » Run to open the Run window.

Enter drive:\setup.exe, where drive is the letter of the drive in which you
inserted the CD. Click OK.

The following message is briefly displayed:

Instal1Shield(R) is preparing the InstallShield Wizard, which
will guide you through the rest of the process.
Please wait .........

Preparing Java (tm) Virtual Machine

You are then prompted to select the language to use for the installation wizard.
Select the language to use, and then click OK.

The Welcome panel is displayed.

Read the information on the Welcome panel, and then click Next.

The License Agreement panel is displayed.

Read the license agreement and perform one of the following actions:

» Click | accept the terms in the license agreement, and then click Next to
continue with the installation.

« Click I do not accept the terms of the license agreement, and then click
Cancel to exit the installation.

When you click Next, the wizard verifies that your system meets the hardware
requirements for the installation.

Note: If your system does not meet hardware requirements, the wizard opens
a panel that warns you about a decrease in the performance level if
these requirements are not met. Click OK to close the warning panel.

A panel is displayed for you to select the destination directory for your master
console software installation. By default, the master console software is
installed in C:\Program Files\IBM\MasterConsole

Click Next to accept the default directory. If you want to change the directory,
click Browse, select a different directory, and then click Next.

The installation wizard compares the list of components to be installed with the
products that are already installed on your system. If the wizard finds that any
master console components are already installed, it compares the versions
and uses the following logic to determine which components to install:

» |If the component is not installed or the installed version is an earlier version
than the required version, the component is installed or upgraded by
launching the component-specific installation program.

« |If the component is installed at the same version level as the version that is
installed by the installation wizard, the wizard does not install the
component.

» If the installed component is a later version than the version to be installed,
the installation wizard does not install the component, but a warning that
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10.
11.

12.

13.

14.

indicates that this version is not tested with the master console is displayed.
Click OK if you see this warning. Decide whether you want to continue the
installation or exit the installation so that you can first remove the later
version from your system. If you remove the later version, restart the master
console installation wizard after the removal.

» If a component is incorrectly installed on the system, you are asked to
continue with the installation by reinstalling the component with the
component-specific installer. If the reinstallation does not succeed, you must
exit the master console installation wizard, manually remove the product
from your system, and restart the master console installation wizard.

After the wizard performs the comparison, the Product List panel is displayed.

This panel provides the following information:

» Versions of existing master console components
* Required versions
» Actions to be done by the installation wizard or by you

If you need to refer to the installation product list later, this information is saved
on your system in the MasterConsoleProducts.htm file. This file is located in
the directory that you specified for the master console installation.

After you have reviewed the information presented in the Product List panel,
click Next.

The PUTTY installation panel is displayed.
Click Next to begin the installation of PuTTY.
Click Next when the wizard indicates that PuTTY has been installed.

The installation wizard validates the installation of PuTTY. If the validation is
not successful, an error panel is displayed and you must exit the wizard,
correct the errors, and restart the installation wizard.

Before continuing with the installation wizard, create an SSH key pair using
PuTTY. Follow the instructions that are described in the [‘Generating an SSH|
[key pair using PUTTY” on page 17| topic. After you have created the SSH key
pair, return to these instructions.

The next part of the installation wizard uses the generated SSH key pair to
install the SAN Volume Controller Console.

Click Next to launch the SAN Volume Controller Console installation program.

The SAN Volume Controller Console installation program opens in a new
window.

Important: Do not close the main master console installation wizard panel
while you complete the SAN Volume Controller Console
installation program.

From the SAN Volume Controller Console installation program, perform the
following steps to install the SAN Volume Controller Console:

a. Click Next in the Welcome panel.

b. Click | accept the terms of the license agreement, and then click Next in
the License Agreement panel.

c. Click Next in the Destination Directory panel to accept the default directory.

d. Enter the private key that you created in step (the default key name is
icat.ppk), and then click Next.

e. Click Next in the CIMOM ports panel to accept the default ports.

f. Click Next to accept the default ports for the embedded WebSphere®
Application Server.
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15.

16.

17.
18.

g. Click Install in the installation confirmation panel to install the SAN Volume
Controller Console.

h. (Optional) Click View post installation tasks to view the steps that you
must later perform to access the SAN Volume Controller Console.

i. Click Finish to complete the installation and close the SAN Volume
Controller Console installation program.

The SAN Volume Controller Console installation program closes and control
is returned to the main master console installation wizard.

In the main master console installation wizard, click Next.

The wizard validates the installation of the SAN Volume Controller Console. If
the validation is successful, the Finish panel is displayed. If the validation fails,
an error panel is displayed. If errors are found, exit the wizard, correct the
errors, and restart the master console installation wizard.

Review the master console installation log (mclog.txt) to ensure that all
components are properly installed. The log file is located in
installation_directonjlogs, where installation_directory is the directory where
the master console was installed. The default installation directory is
C:\Program Files\IBM\MasterConsole.

Click Finish to complete the installation.

If a system restart is required, accept the prompt to complete the master
console installation process.

Mirroring the boot drive

You can use the Microsoft Windows software mirroring capability to mirror the boot
drive on the master console system.

Note: The master console hardware option is delivered with the boot drive already

mirrored.

Before you mirror the boot drive, ensure that you meet the following prerequisites:

* You must have a second drive that is as large or larger than your original boot
drive.

 If the target disk has a partition that is assigned to it (that is, it already has a
drive letter), perform the following steps to remove the partition:

1.

Back up any necessary data on the existing partition. When you remove an
existing partition, you lose any data that is on it.

Remove the partitioning by right-clicking My Computer, selecting Manage -~
Storage ~ Disk Management, right-clicking the target disk drive, and then
selecting Delete Partition.

Perform the following steps to mirror the boot drive:

1.

A

Right-click My Computer on the desktop.

Click Manage.

Click Storage » Disk Management.

Right-click the disk icon for the system disk.

Convert the disk to a dynamic disk by performing the following actions:
For Windows 2000 systems:

a. Click Upgrade to dynamic disk and then click OK.

b. Right-click the disk icon for the disk that you want to become the mirror of
the system disk.
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c. Click Upgrade to dynamic disk and then click OK.

d. If you receive a warning, click Yes.

e. If your system restarts, restart the Disk Management utility.
For Windows 2003 systems:

Click Convert to dynamic disk.

Select both drives and click OK.

Click Convert.

Click Yes to continue when you receive an operating system boot warning.
Click Yes to unmount file systems and to continue.

f. Allow the system to reboot.

g. Restart the Disk Management utility

6. For Windows 2000 systems, right-click the disk icon for the system disk or, for
Windows 2003 systems, right-click the system disk partition.

7. Click Add Mirror.

8. Select the disk that you want to become the mirror of the system disk, and
then click Add Mirror.

9. Click OK to continue when you receive a warning indicating that you must
update the boot.ini file.

10. Perform the following steps to update the boot.ini file:
a. Double-click My Computer on the desktop.
b. Click Tools » Folder options.
c. Click the View tab.
d. In the Advanced settings list, perform one of the following actions,
depending on your operating system:
* For Windows 2000 systems, select Show hidden files and folders.

* For Windows 2003 systems, select Show hidden files and folders and
clear the Hide protected operating system files option. Click Yes
when you receive a warning.

e. In the My Computer window, click Local disk (C:).
Open the C:\boot.ini file in a text editor.

Attention: Be cautious when you edit this file and make only the specified
changes. Do not modify any other lines in this file.

g. In the operating system section, add Primary to the end of the operating
description for the system disk.

h. Copy the line for the system disk, change Primary to Secondary, and
change the system disk (for example, rdisk(0)) to mirrored disk (for
example, rdisk(1)). The file looks similar to one of following examples.

Windows 2000 example:

© o0 T

—

[boot Toader]

timeout=30 default=multi(0)disk(0)rdisk(0)partition(1)\WINNT

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINNT="Microsoft Windows 2000 Advanced
Server Primary" /fastdetect

multi(0)disk(0)rdisk(1)partition(1)\WINNT="Microsoft Windows 2000 Advanced
Server Secondary" /fastdetect

Windows 2003 example:
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/,
[boot loader]

timeout=30

default=multi(0)disk(0)rdisk(0)partition(1)\WINDOWS

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows Server 2003,
Standard Primary" /fastdetect

multi(0)disk(0)rdisk(1)partition(1)\WINDOWS="Windows Server 2003,
Standard Secondary" /fastdetect )

i. Save and close the file.

j- Restart the machine.
After the machine completes the Power On Self Test (POST), the system
prompts you to select the Windows operating system to use for the boot
process

k. Select the secondary operating system and press Enter to verify that the
machine successfully restarts from the mirrored drive.

I. Restart the machine again.
After the machine completes the POST, the system again prompts you to
select the Microsoft Windows operating system to use for the boot process.

m. Select your operating system and press Enter to verify that the machine

successfully restarts from the system drive.
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Chapter 3. Configuring the master console

You can configure the master console to access the SAN Volume Controller
Console and the SAN Volume Controller command-line interface (CLI). If you
installed the master console on your own hardware, you have already performed
some of these steps during the installation process.

If you purchased the hardware master console and experience a problem, use the
2145 machine type and the serial number of a SAN Volume Controller node that
was installed with the master console to open a hardware problem.

Perform the following steps to configure the master console:

1. Log on as a local administrator (for example, as the Administrator user) to the
system where the master console software is installed.

Note: If you installed the software master console, skip to step @ because you
already performed the tasks described in step [2| before or during the
installation of the master console software.

2. If you purchased a hardware master console, perform the following configuration
steps:

a. Optionally, reconfigure the master console host name. When you receive the

hardware master console, the host name is preconfigured as mannode. If you

choose to change this name see [‘Changing the master console host name’|

on page 16|for more information.

b. Configure the internal IP network connection (Local Area Network).
[‘Configuring the internal IP network connection” on page 16 provides more
details for this step.

c. Configure the browser. [“Checking your Web browser and settings before]
[accessing the SAN Volume Controller Console” on page 19 provides more
details for this step.

d. Generate an SSH key pair using the PuTTYgen. [‘Generating an SSH key|
[pair using PUTTY” on page 17|provides more details for this step.

3. For a software master console or a hardware master console, perform the
following configuration steps:

a. Configure a default PUTTY session for command-line interface (CLI) access.
[‘Configuring a PUTTY session for the CLI” on page 18| provides more details
for this step.

b. Store keys in the SAN Volume Controller Console software. ['Storing the]

rivate SSH key in the SAN Volume Controller Console software” on page]
18| provides more details for this step.

c. Install your chosen antivirus software on the master console system.

Configuring the host name

If you installed the master console software on your own hardware, you must set up
the master console host name using the IP configuration information that you have
specified during planning.

Note: If you have a hardware master console, the host name is preconfigured as
mannode.

Perform the following steps to configure the host name for the master console:
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1. From the desktop, right-click the My Computer icon and select Properties.

2. Click the Network Identification tab.

3. Click Properties.

4. Enter the master console name in the Computer name field.

5. Click More.

6. Enter the full path information in the Primary DNS suffix for this computer
field.

7. Click OK until you return to the desktop.

8. Restart the master console.

Changing the master console host name

You can change the master console host name anytime. When you change the host
name, you must also be sure that other master console applications are updated to
use the new name.

Perform the following steps to change the host name and to update the name in
other master console applications:

Right-click on My Computer from the desktop.

Click Properties.

Click Computer Name.

Click Change.

Type the master console host name in the Computer name field.

Click More.

Type the full path information in the Primary DNS suffix of this computer field.
Click OK until you return to the desktop.

Click Yes to restart the master console system so that the change to the host
name is applied.

© O N Ok DNd=

Configuring the internal IP network connection

Before you can use the master console, you must configure the internal IP network
connection.

If you are using the master console on an IPv6 network, you must ensure that it is
configured to run IPv6. See the Microsoft knowledge base for more information on
setting up IPv6 on your operating system.

Perform the following steps to configure the Local Area Connection:
From the desktop, right-click My Network Places.

Click Properties.

Right-click Local Area Connection.

Click Properties.

Click Internet Protocol (TCP/IP).

Click Properties.

Type all required information for the IP and DNS addresses.

N o~ =

Note: You do not have to use a static TCP/IP address. If you only want to
access the master console directly, you can use a DHCP TCP/IP
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8.
9.

address. If you use a DHCP TCP/IP address, ensure that the properties
are set to DHCP. To access the master console remotely, you must use a
static IP address.

Click OK until you return to the desktop.
Connect the Ethernet port to the network.

Generating an SSH key pair using PuTTY

You must generate a Secure Shell (SSH) key pair to use the SAN Volume
Controller Console and the command-line interface (CLI).

Perform the following steps to generate SSH keys on the IBM System Storage
Productivity Center (SSPC) or master console using the PuTTY key generator
(PuTTYgen):

1.

Start PuTTYgen by clicking Start > Programs > PuUTTY » PuTTYgen. The
PuTTY Key Generator panel is displayed.

Click SSH-2 RSA as the type of key to generate.

Note: Leave the number of bits in a generated key value at 1024.

Click Generate and then move the cursor around the blank area of the Key
section to generate the random characters that create a unique key. When the
key has been completely generated, the information about the new key is
displayed in the Key section.

Attention: Do not modify the Key fingerprint or the Key comment fields; this
can cause your key to no longer be valid.

(Optional) If you are generating SSH keys for a computer other than the SSPC
or master console, enter a passphrase in the Key passphrase and Confirm
passphrase fields. The passphrase encrypts the key on the disk; therefore, it is
not possible to use the key without first entering the passphrase.

Attention: If you are generating the key pair for the SSPC or master console,
do not enter anything in the Key passphrase or the Confirm passphrase fields.

Save the public key by performing the following steps:

a. Click Save public key. You are prompted for the name and location of the
public key.

b. Type icat.pub as the name of the public key and specify the location where
you want to save the public key. For example, you can create a directory on
your computer called keys to store both the public and private keys.

c. Click Save.

Save the private key by performing the following steps:

a. Click Save private key. The PuTTYgen Warning panel is displayed.
b. Click Yes to save the private key without a passphrase.

c. Type icat as the name of the private key, and specify the location where
you want to save the private key. For example, you can create a directory
on your computer called keys to store both the public and private keys. It is
recommended that you save your public and private keys in the same
location.

d. Click Save.
Close the PUTTY Key Generator window.
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Storing the private SSH key in the SAN Volume Controller Console

software

For both the hardware and software versions of the IBM System Storage
Productivity Center or master console, when the SSH keys that are used to
communicate with the SAN Volume Controller node are generated or changed, you
must store a copy of the new private key in the SAN Volume Controller Console
software.

Perform the following steps to store a copy of the new private key in the SAN
Volume Controller Console software:

1. Open a command prompt window.
2. Type the following command:

copy path\icat.ppk C:\"Program Files"\IBM\svcconsolelcimom

where path is the path where you stored the SSH private key when it was
generated and C:\"Program Files"\IBM\svcconsole\cimom is the location where
you installed the SAN Volume Controller Console.

Important: Directory names with embedded spaces must be surrounded by
double quotation marks.

3. Close the command prompt window.

Configuring a PUuTTY session for the CLI

You must configure a PUTTY session using the Secure Shell (SSH) key pair that
you have generated before you can use the command-line interface (CLI).

Attention: Do not run scripts that create child processes that run in the
background and call SAN Volume Controller commands. This can cause the system
to lose access to data and cause data to be lost.

Perform the following steps to configure a PUTTY session for the CLI:

1. Select Start » Programs » PuTTY » PuTTY. The PuTTY Configuration window
opens.

2. Click Session in the Category navigation tree. The Basic options for your
PuTTY session are displayed.

3. Click SSH as the Protocol option.

4. Click Only on clean exit as the Close window on exit option. This ensures
that connection errors are displayed.

5. Click Connection » SSH in the Category navigation tree. The options
controlling SSH connections are displayed.

6. Click 2 as the Preferred SSH protocol version.

7. Click Connection » SSH » Auth in the Category navigation tree. The Options
controller SSH authentication are displayed.

8. Click Browse or type the fully qualified file name and location of the SSH
client and private key in the Private key file for authentication field. The file
that you specify in this field is the one that you stored in the SAN Volume
Controller software (for example, C:\Program Files\IBM\svcconsole\cimom\
icat.ppk).

9. Click Session in the Category navigation tree. The Basic options for your
PuTTY session are displayed.
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10. Click Default Settings and then click Save.

11. Type the name or IP address of the SAN Volume Controller cluster in the Host
Name (or IP Address) field.

12. Type 22 in the Port field. The SAN Volume Controller cluster uses the standard
SSH port.

13. Type the name that you want to use to associate with this session in the
Saved Sessions field. For example, you can name the session SAN Volume
Controller Cluster 1.

14. Click Save.

You have now configured a PuTTY session for the CLI.

Routing configuration

You can add a route to your DNS server and Gateway IP.

Perform the following steps if you do not know the IP address of the master console
gateway:
1. Open a command prompt window.
2. lIssue the following command:
route print
At the bottom of the table the gateway is specified as the Default Gateway.

For every DNS server that is used by the master console, a specific route must be
configured. You must configure a specific route for every device that you want to
manage from the master console.

Note: If these routes are not configured, the master console cannot contact
devices that are on a different subnet.

Perform the following steps to add the route for your DNS server:

1. Issue the following command:
route -p add DNS_Server_ IP_Address MASK Gateway IP_Address
Where DNS_Server_IP_Address is the DNS server IP address for Local Area
Connection 2 and Gateway_IP_Address is the IP address of the gateway for
Local Area Connection 2.

2. Issue the following command to add the routes for the other managed devices:
route -p add DNS_Server_IP_Address MASK Gateway IP_Address
Where DNS_Server_IP_Address is the DNS server IP address of the device

that you want to manage and Gateway_IP_Address is the IP address of the
gateway for the device that you want to manage.

Checking your Web browser and settings before accessing the SAN
Volume Controller Console

To access the SAN Volume Controller Console, you must ensure that your Web
browser is supported and set to allow pop-up windows.

See the SAN Volume Controller Console support information on the following Web
site for the supported operating systems and Web browsers:

www.ibm.com/storage/support/2145|
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Perform the following steps to configure your Web browser:
1. Ensure that the Web browser is not set to block or suppress pop-up windows.

Note: If you are using Internet Explorer 7.0 and receive a message that a
pop-up window has been blocked, click the Information Bar at the top of
the browser and select Always allow popups from this site. If you
receive a message that content was blocked because it was not signed
by a valid security certificate, click the Information Bar at the top of the
screen and select Show blocked content.

2. Ensure that you have not installed any applications on the Web browser that
block or suppress pop-up windows. If such an application is installed with the
Web browser, uninstall it or turn it off.

3. Disable the proxy setting by performing the following steps:

For Netscape:

a.

c.
d.

Open your Netscape browser and click Edit > Preferences. The
Preferences window displays.

From the left side category, click Advanced to expand the
secondary options. The suboption Proxies displays.

Click Proxies. The Proxies window displays.
Select Direct connection to Internet.

For Internet Explorer:

a.
b.

Click Tools - Internet Options » Connections > LAN Settings.
Click to clear the Use a proxy server box.

4. (Optional) Perform the following steps to add password protection so that your
password does not display when you type it in:

For Netscape:

a.

® a0 o

f.

Start a Netscape session.

Click Edit » Preferences from the menu bar.
Click Privacy and Security.

Click Web Passwords.

Ensure that the Remember passwords for sites that require me
to log in box is unchecked.

Click OK.

For Internet Explorer:

a.
b.

Start an Internet Explorer session.

Click Tools - Internet Options from the menu bar. The Internet
Options panel is displayed.

Click the Content tab.

Click AutoComplete. The AutoComplete Settings panel is
displayed.

Ensure that the User names and passwords on forms box is
unchecked.

Click OK.
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Chapter 4. Maintaining the master console software

The topics in this section help you maintain the master console software on your
system.

You can perform any of the following activities to maintain your master console
software:

» Upgrade all of some of the master console components, including the SAN
Volume Controller Console, using the master console installation program.

* Upgrade only the SAN Volume Controller Console component by using a
downloaded installation wizard.

* Uninstall individual master console software components.

Upgrading the master console software

The topics in this section guide you through the upgrade process for the master
console software using the master console installation program.

Prerequisites for upgrading the master console

This topic provides an overview of the prerequisites for upgrading the master
console.

Before you upgrade the master console, you must meet the following prerequisites:

* Ensure that your system meets the master console hardware and software
requirements provided in the IBM System Storage SAN Volume Controller
Hardware Installation Guide.

* You must be logged into the master console server using a user ID with
administrative privileges.

 If you are upgrading the master console software from version 3.2 or an earlier
version, you might be required to uninstall some components that were
previously included with the master console. provides a list of master
console components that are not supported beginning with version 4.2 and the
prerequisite actions to take.

Table 1. Unsupported components and actions to take prior to upgrading

Component Action

IBM Tivoli® Storage Area Network Manager | You must manually uninstall the Tivoli SAN
(Tivoli SAN Manager) Agent Manager Agent. Thel“UninstaIIing Tivoli SAN|
[Manager Agent” on page 24| topic provides
instructions for uninstalling this component.

IBM Tivoli SAN Manager You must manually uninstall the Tivoli SAN
Manager. The [‘Uninstalling Tivoli SAN|
[Manager” on page 25|topic provides
instructions for uninstalling this component.

DS4000 Storage Manager Client (FASIT Unless you currently use the DS4000
Storage Manager Client) Storage Manager Client, uninstall it to free
up resources on the server. |“Uninstal|inc the|
DS4000 Storage Manager Client (FASt
Storage Manager Client)” on page 25|
provides instructions for uninstalling this
component.
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Table 1. Unsupported components and actions to take prior to upgrading (continued)

Component Action

IBM Connection Manager The IBM Connection Manager is
automatically uninstalled during the master
console upgrade process. You do not need
to take any action.

IBM Director The upgrade process works best if you
uninstall the IBM Director before you
upgrade the master console software, but
this is not mandatory.

Upgrading using the master console installation wizard

22

After you upgrade the SAN Volume Controller Console to V4.2.1 you can use the
master console installation wizard to upgrade all the master console components to
version 4.2.1.

Upgrade the master console software before you upgrade the SAN Volume
Controller cluster software to version 4.2.1.

Before you begin the upgrade process, ensure that you have performed the
following actions:

* Logged in using a user ID with administrative privileges.

» Uninstalled any components that are not supported by the new version. For more
information, see |“Prerequisites for upgrading the master console” on page 21 |

Perform the following steps to upgrade the master console software:
1. Insert the master console software installation CD in the CD drive.
2. Click Start » Run to open the Run window.

3. Enter drive:\setup.exe, where drive is the letter of the drive in which you
inserted the CD. Click OK.

The following message is briefly displayed:

InstallShield(R) is preparing the InstallShield Wizard, which
will guide you through the rest of the process.
Please wait .........

Preparing Java (tm) Virtual Machine

You are then prompted to select the language to use for the installation wizard.
4. Select the language to use, and then click OK.

The Welcome panel is displayed.
5. Read the information on the Welcome panel, and then click Next.

The License Agreement panel is displayed.
6. Read the license agreement and perform one of the following actions:

» Click I accept the terms in the license agreement, and then click Next to
continue with the installation.

» Click I do not accept the terms of the license agreement, and then click
Cancel to exit the installation.

When you click Next, the wizard verifies that your system meets the hardware
requirements for the installation.
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10.

11.

Note: If your system does not meet hardware requirements, the wizard opens
a panel that warns you about a decrease in the performance level if
these requirements are not met. Click OK to close the warning panel.

A panel that shows you the destination directories for your master console
software installation is displayed.

Click Next.

The installation wizard compares the list of components to be installed with the
products that are already installed on your system. If the wizard finds that any
master console components are already installed, it compares the versions
and uses the following logic to determine which components to install:

» |If the component is not installed or the installed version is an earlier version
than the required version, the component is installed or upgraded by
launching the component-specific installation program.

» If the component is installed at the same version level as the version that is
installed by the installation wizard, the wizard does not install the
component.

 If the installed component is a later version than the version to be installed,
the installation wizard does not install the component, but a warning that
indicates that this version is not tested with the master console is displayed.
Click OK if you see this warning. Decide whether you want to continue the
installation or exit the installation so that you can first remove the later
version from your system. If you remove the later version, restart the master
console installation wizard after the removal.

* If a component is incorrectly installed on the system, you are asked to
continue with the installation by reinstalling the component with the
component-specific installer. If the reinstallation does not succeed, you must
exit the master console installation wizard, manually remove the product
from your system, and restart the master console installation wizard.

After the wizard performs the comparison, the Product List panel is displayed.
This panel provides the following information:

» Versions of existing master console components

* Required versions

» Actions to be done by the installation wizard or by you

From the List of products panel, click Next to continue upgrading the products.

The installation wizard launches the necessary component-specific installation
programs.

Note: Upgrades to the master console software components are also
available at the following Web site: www.ibm.com/storage/support/2145
Instructions for downloading and installing upgraded software packages
are available at this site too.

Follow the instructions on the panels for each master console component that
must be upgraded. Click Finish when all the components have been installed.

If a system restart is required, accept the prompt to complete the master
console installation process.

Review the master console installation log (mclog.txt) to ensure that all
components are properly installed. The log file is located in
installation_director)\logs, where installation_directory is the directory where
the master console was installed. The default installation directory is
C:\Program Files\IBM\MasterConsole.
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Uninstalling master console software

To uninstall the master console software, you must remove the components
separately.

Because of product dependencies, you must uninstall the software packages in a
specific order. If you have any of the following components and plan to uninstall
them, be sure to uninstall them in the following order.

Note: Some of the components that are listed were distributed in previous versions
of the master console.

IBM Director

Tivoli SAN Manager Agent

Tivoli SAN Manager

DS4000 Storage Manager Client (FAStT Storage Manager Client)

Some of the listed components that were distributed in previous versions of the

SAN Volume Controller Console.

PuTTY

Adobe Acrobat Reader

Master console

o0~

© N

Note: When you remove the master console, you remove some documentation,
support utilities, and icons. The documentation that is uninstalled with the
master console option is located in <destination_location>\Documents,
where <destination_location> is the location where the master console
was installed on the system. The default location is system_drive\
Program Files\IBM\MasterConsole.

Uninstalling IBM Director

This topic describes how to uninstall IBM Director from the master console using
the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall IBM Director:

1. In the Add/Remove Programs panel, scroll to IBM Director, and click to select
it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling Tivoli SAN Manager Agent
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This topic describes how to uninstall Tivoli SAN Manager Agent from your master
console hardware using the Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the Tivoli SAN Manager Agent:
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1. In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area Network
Manager - Agent, and click to select it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish.

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

Uninstalling Tivoli SAN Manager

This topic describes how to uninstall Tivoli SAN Manager from your master console
hardware using the Add/Remove Programs dialog panel.

This procedure assumes that you have performed the following actions:
* Uninstalled the Tivoli SAN Manager Agent
» Accessed the Add/Remove Programs dialog panel

Perform the following steps to uninstall the Tivoli SAN Manager:

1. In the Add/Remove Programs panel, scroll to IBM Tivoli Storage Area Network
Manager - Manager, and click to select it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish.

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

6. Remove the directory where the Tivoli SAN Manager and the Tivoli SAN
Manager Agent were installed. By default, this directory is C:\Tivoli.

Uninstalling the DS4000 Storage Manager Client (FAStT Storage
Manager Client)

This topic describes how to uninstall the DS4000 Storage Manager Client (FAStT
Storage Manager Client) from the master console using the Add/Remove Programs
dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall the DS4000 Storage Manager Client (FAStT
Storage Manager Client):

1. In the Add/Remove Programs panel, scroll to the product name, and click to
select it.

2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish.

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.
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Uninstalling PuTTY

This topic describes how to uninstall PuTTY from the master console using the
Add/Remove Programs dialog panel.

This procedure assumes that you have accessed the Add/Remove Programs dialog
panel.

Perform the following steps to uninstall PuTTY:
1. In the Add/Remove Programs panel, scroll to PuTTY, and click to select it.
2. Click Change/Remove.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

Uninstalling Adobe Reader

You can uninstall Adobe Reader from the master console.

Perform the following steps to uninstall Adobe Reader:
1. Open the Add or Remove Programs window from the Windows Control Panel.

2. Find and select the line for Adobe Reader in the Add or Remove Programs
window.

3. Click Remove or Change.

4. Navigate through the uninstallation wizard, selecting the Next button of each
window.

5. Wait for the program to be removed, and then click Finish.

Uninstalling the master console
This topic describes how to uninstall the master console.

This procedure assumes that you have opened the Microsoft Windows Add or
Remove Programs dialog box.

Perform the following steps to uninstall the master console:

1. Find and select IBM System Storage Master Console for SAN Volume
Controller in the Add or Remove Programs window.

2. Click Remove or Change.

3. Navigate through the uninstallation wizard, selecting the Next button of each
window.

4. Wait for the program to be removed, and then click Finish

5. If you are prompted to reboot the system, answer yes to reboot the system and
complete the removal of the product.

To complete the removal process, you can remove the directory where the master

console was installed. The default is system_drive\Program Files\IBM\Master
Console.
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Chapter 5. Troubleshooting the master console

These topics provide information that can help you troubleshoot and resolve
problems with the master console server.

In addition to troubleshooting on your own, you can also request an Assist On-site
session with an IBM service representative.

For SAN Volume Controller version 4.2.1 and earlier, the master console provides a
single point from which to manage the SAN Volume Controller nodes. An existing
master console can be upgraded to support clusters that are running the latest SAN
Volume Controller software.

Beginning with SAN Volume Controller version 4.3.0, the IBM System Storage
Productivity Center (SSPC) is an integrated hardware and software solution that
provides a single point of entry for managing SAN Volume Controller clusters, IBM
System Storage DS8000 systems, and other components of your data storage
infrastructure.

Use the following topics to resolve problems with the master console server.

Clearing the Microsoft Windows event logs

When you change the IBM System Storage Productivity Center or master console
IP address or host name, you might create entries in the Microsoft Windows event
logs.

Clear all three logs to ensure that these log entries do not cause confusion when
you try to isolate problems.

The following procedure assumes that your Windows desktop is displayed.

Perform the following steps to clear the event logs:
1. Right-click My Computer and select Manage.
2. Expand Event Viewer.

3. Right-click Application and select Clear All Events. Click No when you are
asked if you want to save the log before clearing.

4. Right-click Security and select Clear All Events. Click No when you are asked
if you want to save the log before clearing.

5. Right-click System and select Clear All Events. Click No when you are asked
if you want to save the log before clearing.

6. Close the computer management window.

Troubleshooting Microsoft Windows boot problems

Use this section to help you resolve Microsoft Windows boot problems on the
master console system.

Perform the following actions to resolve Windows boot problems:

» If you cannot start the Windows system from the boot drive, try to start the
master console system from the second disk drive (the mirrored disk).
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 If you continue to have problems starting the system from either the boot disk
drive or the second disk drive, you must replace the corrupted disk drive, and
then mirror the boot drive again.

Note: After you set up mirroring, the hard disk drive on the system that runs the
master console is actually a mirrored pair of hard disks. This strategy
protects against loss of access to the master console due to a disk failure.
This mirroring can help you start the master console system if the boot disk
does not work. Whenever you replace one of the disks on your master
console, you must make sure that you mirror the disks again.

Starting the master console hardware from the mirrored disk

During the Microsoft Windows boot process on the master console hardware, if
Windows tries to start but fails with an Inaccessible Boot Device message on a
blue screen, and another restart attempt does not solve the problem, the Windows
boot code on the startup device might be corrupted.

The following instructions require that you use the administrator password for the
power-on password when you restart the system. If the system is set up with an

administrator password and you use a regular power-on password, you can see

only a limited version of the Configuration/Setup menu.

Perform the following steps to resolve the problem:

1. Restart the master console system and watch the screen. When the Press F1
for Configuration/Setup message appears, press F1.

The main menu for Configuration/Setup Utility is displayed.
Select Start Options from the main menu.

Select Start Sequence.

Step down the sequence to the one that contains the hard disk.

Use the left and right cursor keys to select the other hard disk. For example, if
the hard disk is set to 1, select 0. If the hard disk is set to 0, select 1.

6. Press Esc to exit each menu until the option to save and exit is displayed.
Select Yes to save the changes and exit the Configuration/Setup Utility.

7. If the master console system starts, proceed with the steps for recovering from
a master console disk failure. If the master console system does not start,
contact your IBM service representative.

Al A

Replace a disk on the master console server
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If one of the disk drives on the master console server fails, you might need to
replace it with a new disk drive. The new drive must be the same capacity or larger
than the drive being replaced.

Perform the following steps if one of the mirrored disk drives fails and must be
replaced:

1. If you cannot determine which of the two disk drives has failed, restart the
server with each disk drive to determine which drive is not functioning.

2. Right-click the My Computer icon on your desktop and select Manage.

3. Select Disk Management from the left navigation panel. The hard drives are
displayed in the right panel.

4. |If the failing disk drive is displayed, right-click the main volume of the drive and
select Break Mirror.
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10.

11.
12.

13.
14.

Shut down the master console hardware and replace the failing disk drive
using the procedures that are detailed in the documentation for your
replacement hard drive. Ensure that the jumper settings for the new drive are
the same as the jumper settings for the drive that is being replaced.

Notes: If the replacement drive has a master boot record (MBR), erase the
MBR prior to using the replacement drive. However, if the master
console computer fails to start because it cannot find the MBR, change
the start sequence in the BIOS to the other hard drive.

Restart the computer.
Right-click My Computer on your desktop and select Manage.
Select Disk Management. The hard drives are displayed in the right panel.

If a disk drive is marked Missing, right-click the drive and select Remove
Disk.

If a no entry sign is displayed on the new disk drive, right-click that disk drive
and select Write Signature. This removes the no entry sign.

Right-click the new disk drive and select Upgrade to Dynamic Disk.

Right-click the volume that you want to mirror and select Add Mirror. The Add
Mirror wizard is started.

Use the Add Mirror wizard to configure the second volume.
Ignore the window for making changes to the boot.ini file.

The status of both volumes, the existing drive, and the new drive changes to
Regenerating. After a short period of time, the status shows the percentage of
regeneration that has completed. When the regeneration completes, the status
is displayed as Healthy.

Master console recovery procedures

If the master console server disk drive fails and the master console software is also
lost, the hardware master console software can be restored to the factory default
settings.

The master console server uses a mirrored pair of disk drives to protect the master
console software in case a disk drive fails. However, if both copies of the software
are also destroyed, you can restore the software to the factory default settings by
using the CDs that are supplied with the hardware master console.

Complete the following steps to restore the master console software to the factory
default settings:

Hardware master console V4.1 and later

1.

2.
3.
4.

Inspect your recovery CDs. Beginning with version 4.1, IBM provides a separate
Microsoft Windows CD in addition to the software Master console CDs.

Reinstall the Windows operating system using the supplied Windows CDs.
Install the master console software from the supplied CDs.
Configure the master console software.

Hardware master console versions prior to V4.1

1.

2.

Inspect your recovery CDs. Prior to version 4.1, the set of recovery CDs
contains both Microsoft Windows and the master console software in one
bundle.

Insert recovery CD 1.
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3. Power off the master console server.
4. Power on the master console server and follow the on-screen instructions.
5. Configure the master console software.
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Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use software products successfully.

Features

These are the major accessibility features in the SAN Volume Controller Console :

* You can use screen-reader software and a digital speech synthesizer to hear
what is displayed on the screen. The following screen readers have been tested:
WebKing v5.5 and Window-Eyes v5.5.

* You can operate all features using the keyboard instead of the mouse.
Navigating by keyboard

You can use keys or key combinations to perform operations and initiate many
menu actions that can also be done through mouse actions. You can navigate the
SAN Volume Controller Console and help system from the keyboard by using the
following key combinations:

» To traverse to the next link, button, or topic, press Tab inside a frame (page).
* To expand or collapse a tree node, press » or ¢, respectively.

* To move to the next topic node, press V or Tab.

* To move to the previous topic node, press ~ or Shift+Tab.

» To scroll all the way up or down, press Home or End, respectively.
* To go back, press Alt+«.

» To go forward, press Alt+-.

» To go to the next frame, press Ctrl+Tab.

» To move to the previous frame, press Shift+Ctrl+Tab.

» To print the current page or active frame, press Ctrl+P.

* To select, press Enter.

Accessing the publications
You can view the publications for the SAN Volume Controller in Adobe Portable

Document Format (PDF) using the Adobe Acrobat Reader. The PDFs are provided
at the following Web site:

www.ibm.com/storage/support/2145|
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATIONS "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation

Almaden Research

650 Harry Road

Bldg 80, D3-304, Department 277
San Jose, CA 95120-6099
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available
for it are provided by IBM under terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM
has not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products may be addressed to the suppliers of those
products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to IBM,
for the purposes of developing, using, marketing or distributing application programs
conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs.
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If you are viewing this information softcopy, the photographs and color illustrations
may not appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. If these and other IBM trademarked terms are marked on their first
occurrence in this information with a trademark symbol (® or ™), these symbols
indicate U.S. registered or common law trademarks owned by IBM at the time this
information was published. Such trademarks may also be registered or common law
trademarks in other countries. A current list of IBM trademarks is available on the
Web at "Copyright and trademark information” at www.ibm.com/legal/|
icopytrade.shtmil

Adobe and the Adobe logo are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Xeon, and Pentium are trademarks or registered trademarks of
Intel Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

Electronic emission notices

The following electronic emission statements apply to this product. The statements
for other products that are intended for use with this product are included in their
accompanying documentation.

Federal Communications Commission (FCC) statement

Ensure that you are familiar with the Federal Communications Commission (FCC)
statement.

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, might cause interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference, in which
case the user will be required to correct the interference at his own expense.
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Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. Neither the provider nor the manufacturer is responsible
for any radio or television interference caused by using other than recommended
cables and connectors or by unauthorized changes or modifications to this
equipment. Unauthorized changes or modifications could void the user’s authority to
operate the equipment.

This device complies with Part 15 of FCC Rules. Operation is subject to the
following two conditions: (1) this device might not cause harmful interference, and
(2) this device must accept any interference received, including interference that
might cause undesired operation.

Industry Canada compliance statement
This Class A digital apparatus complies with IECS-003.

Avis de conformité a la réglementation d’Industrie Canada

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du
Canada.

New Zealand compliance statement
Ensure that you are familiar with the New Zealand compliance statement.

This is a Class A product. In a domestic environment this product might cause radio
interference, in which event the user might be required to take adequate measures.

European Union EMC Directive conformance statement
Ensure that you are familiar with the European Union (EU) statement.

This product is in conformity with the protection requirements of EU council directive
2004/108/EC on the approximation of the laws of the Member States relating to
electromagnetic compatibility. IBM cannot accept responsibility for any failure to
satisfy the protection requirements resulting from a nonrecommended modification
of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to European Standard EN 55022. The
limits for Class A equipment were derived for commercial and industrial
environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

Ensure that you use properly shielded and grounded cables and connectors in
order to reduce interference to radio and TV communications and to other electrical
or electronic equipment. Such cables and connectors are available from IBM
authorized dealers. IBM cannot accept responsibility for any interference caused by
using other than recommended cables and connectors.

European community contact:

IBM Technical Regulations
Pascalstr. 100, Stuttgart, Germany 70569
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Telephone: 0049 (0)711 785 1176
Fax: 0049 (0)711 785 1283
E-mail: tjahn@de.ibm.com

Germany compliance statement
Deutschsprachiger EU Hinweis:

Hinweis fiir Gerate der Klasse A EU-Richtlinie zur Elektromagnetischen
Vertraglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG
zur Angleichung der Rechtsvorschriften iber die elektromagnetische Vertraglichkeit
in den EU-Mitgliedsstaaten und halt die Grenzwerte der EN 55022 Klasse A ein.

Um dieses sicherzustellen, sind die Gerate wie in den Handblchern beschrieben zu
installieren und zu betreiben. Des Weiteren durfen auch nur von der IBM
empfohlene Kabel angeschlossen werden. IBM Gbernimmt keine Verantwortung fir
die Einhaltung der Schutzanforderungen, wenn das Produkt ohne Zustimmung der
IBM verandert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Gerate muissen mit folgendem Warnhinweis versehen werden:
“Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im
Wohnbereich Funk-Stérungen verursachen; in diesem Fall kann vom Betreiber
verlangt werden, angemessene MaBnahmen zu ergreifen und dafir aufzukommen.*

Deutschland: Einhaltung des Gesetzes iiber die
elektromagnetische Vertraglichkeit von Geréten

Dieses Produkt entspricht dem “Gesetz Uber die elektromagnetische Vertraglichkeit
von Geraten (EMVG)“. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in
der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz liber die

elektromagnetische Vertraglichkeit von Gerdaten (EMVG) (bzw. der
EMC EG Richtlinie 2004/108/EG) fur Gerate der Klasse A

Dieses Gerdt ist berechtigt, in Ubereinstimmung mit dem Deutschen EMVG das
EG-Konformitatszeichen - CE - zu fuhren.

Verantwortlich fir die Konformitéatserklarung des EMVG ist die IBM Deutschland
GmbH, 70548 Stuttgart.

Generelle Informationen:

Das Gerit erfiillt die Schutzanforderungen nach EN 55024 und EN 55022
Klasse A.

Japanese Voluntary Control Council for Interference (VCCI) statement
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People’s Republic of China Class A Electronic Emission Statement
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International Electrotechnical Commission (IEC) statement
This product has been designed and built to comply with (IEC) Standard 950.

United Kingdom telecommunications requirements

This apparatus is manufactured to the International Safety Standard EN60950 and
as such is approved in the U.K. under approval number NS/G/1234/J/100003 for
indirect connection to public telecommunications systems in the United Kingdom.

Korean Class A Electronic Emission Statement
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Ol2Ll|, BOA = MEIE= 0
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Taiwan Class A compliance statement

EEFERE:
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European Contact Information

This topic contains the product service contact information for Europe.
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European Community contact:

IBM Technical Regulations

Pascalstr. 100, Stuttgart, Germany 70569
Tele: 0049 (0)711 785 1176

Fax: 0049 (0)711 785 1283

e-mail: mailto:tjahn@de.ibm.com|

Taiwan Contact Information

This topic contains the product service contact information for Taiwan.

IBM Taiwan Product Service Contact Information:
IBM Taiwan Corporation

3F, No 7, Song Ren Rd., Taipei Taiwan

Tel: 0800-016-888

4 ¥IBM 7 it I i 7 5

B AL TR R 757 31
FEFL : 0800-016-888

f2c00790
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Glossary

This glossary includes terms for the IBM System Storage SAN Volume Controller.

This glossary includes selected terms and definitions from A Dictionary of Storage
Networking Terminology (www.snia.org/education/dictionary), copyrighted 2001 by
the Storage Networking Industry Association, 2570 West EI Camino Real, Suite
304, Mountain View, California 94040-1313. Definitions derived from this book have
the symbol (S) after the definition.

The following cross-references are used in this glossary:

See Refers the reader to one of two kinds of related information:

« Aterm that is the expanded form of an abbreviation or acronym. This
expanded form of the term contains the full definition.

» A synonym or more preferred term.

See also
Refers the reader to one or more related terms.

Contrast with
Refers the reader to a term that has an opposite or substantively different
meaning.

Numerics

2145 A hardware machine type for the IBM System Storage SAN Volume
Controller. Models of the SAN Volume Controller are expressed as the
number 2145 followed by "-xxx", such as 2145-8G4. Hardware models for
the 2145 include 2145-4F2, 2145-8F2, 2145-8F4, 2145-8G4, and 2145-8A4.

A

access mode
One of three different modes in which a logical unit (LU) in a disk controller
system can operate. See also image mode, managed space mode, and
unconfigured mode.

Address Resolution Protocol (ARP)
A protocol that dynamically maps an IP address to a network adapter
address in a local area network.

agent code
An open-systems standard that interprets Common Information Model (CIM)
requests and responses as they transfer between the client application and
the device.

application server
A host that is attached to the storage area network (SAN) and that runs
applications.

ARP See Address Resolution Protocol.

array An ordered collection, or group, of physical storage devices that are used to
define logical volumes or devices.

association
A class that contains two references that define a relationship between two
referenced objects.
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asymmetric virtualization
A virtualization technique in which the virtualization engine is outside the
data path and performs a metadata-style service. The metadata server
contains all the mapping and locking tables while the storage devices
contain only data. See also symmetric virtualization.

auxiliary virtual disk
The virtual disk that contains a backup copy of the data and that is used in
disaster recovery scenarios. See also master virtual disk.

availability
The ability of a system to continue working, with perhaps a decrease in
performance, after individual components fail.

bandwidth
The range of frequencies an electronic system can transmit or receive. The
greater the bandwidth of a system, the more information the system can
transfer in a given period of time.

bitmap
A coded representation in which each bit, or group of bits, represents or
corresponds to an item; for example, a configuration of bits in main storage
in which each bit indicates whether a peripheral device or a storage block is
available or in which each group of bits corresponds to one pixel of a
display image.

blade One component in a system that is designed to accept some number of
components (blades). Blades could be individual servers that plug into a
multiprocessing system or individual port cards that add connectivity to a
switch. A blade is typically a hot-swappable hardware device.

block A unit of data storage on a disk drive.

block virtualization
The act of applying virtualization to one or more block-based (storage)
services for the purpose of providing a new aggregated, higher-level, richer,
simpler, or secure block service to clients. Block virtualization functions can
be nested. A disk drive, RAID system, or volume manager all perform some
form of block-address to (different) block-address mapping or aggregation.
See also virtualization.

Boolean
Pertaining to the processes used in the algebra formulated by George
Boole.

C

cache A high-speed memory or storage device used to reduce the effective time
required to read data from or write data to lower-speed memory or a
device. Read cache holds data in anticipation that it will be requested by a
client. Write cache holds data written by a client until it can be safely stored
on more permanent storage media such as disk or tape.

Call Home
In SAN Volume Controller, a communication service that sends data and
event notifications to a service provider. The machine can use this link to
place a call to IBM or to another service provider when service is required.
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capacity licensing
A type of licensing that grants you the use of a number of terabytes (TB) for
virtualization, a number of terabytes for Metro Mirror and Global Mirror
relationships, and a number of terabytes for FlashCopy® mappings.

cascading
The process of connecting two or more fibre-channel hubs or switches
together to increase the number of ports or extend distances.

CIM See Common Information Model.

CIM object manager (CIMOM)
The common conceptual framework for data management that receives,
validates, and authenticates the CIM requests from the client application. It
then directs the requests to the appropriate component or service provider.

CIMOM
See CIM object manager.

class The definition of an object within a specific hierarchy. A class can have
properties and methods and can serve as the target of an association.

CLI See command line interface.

client A computer system or process that requests a service of another computer
system or process that is typically referred to as a server. Multiple clients
can share access to a common server.

client application
A storage management program that initiates Common Information Model
(CIM) requests to the CIM agent for the device.

cluster
In SAN Volume Controller, up to four pairs of nodes that provide a single
configuration and service interface.

command line-interface (CLI)
A type of computer interface in which the input command is a string of text
characters.

Common Information Model (CIM)
A set of standards developed by the Distributed Management Task Force
(DMTF). CIM provides a conceptual framework for storage management
and an open approach to the design and implementation of storage
systems, applications, databases, networks, and devices.

concurrent maintenance
Service that is performed on a unit while it is operational.

In SAN Volume Controller, the ability for one node in the cluster to be
turned off for maintenance without interrupting access to the VDisk data
provided by the cluster.

configuration node
A node that acts as the focal point for configuration commands and
manages the data that describes the cluster configuration.

connected
In a Global Mirror relationship, pertaining to the status condition that occurs
when two clusters can communicate.

consistency group
A group of copy relationships between virtual disks that are managed as a
single entity.
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consistent copy
In a Metro or Global Mirror relationship, a copy of a secondary virtual disk
(VDisk) that is identical to the primary VDisk from the viewpoint of a host
system, even if a power failure occurred while I/O activity was in progress.

consistent-stopped
In a Global Mirror relationship, the state that occurs when the secondary
virtual disk (VDisk) contains a consistent image, but the image might be
out-of-date with respect to the primary VDisk. This state can happen when
a relationship was in the consistent-synchronized state when an error
occurred that forced a freeze of the consistency group. This state can also
happen when a relationship is created with the create-consistent flag set to
TRUE.

consistent-synchronized
In a Global Mirror relationship, the status condition that occurs when the
primary virtual disk (VDisk) is accessible for read and write I/O operations.
The secondary VDisk is accessible for read-only I/O operations. See also
primary virtual disk and secondary virtual disk.

container
A data storage location; for example, a file, directory, or device.

A software object that holds or organizes other software objects or entities.

contingency capacity
Initially, a fixed amount of unused real capacity that is maintained on a
space-efficient virtual disk that is configured to automatically expand its real
capacity. It is also the difference between the used capacity and the new
real capacity when the real capacity is changed manually.

copied
In a FlashCopy mapping, a state that indicates that a copy has been started
after the copy relationship was created. The copy process is complete and
the target disk has no further dependence on the source disk.

copying
A status condition that describes the state of a pair of virtual disks (VDisks)
that have a copy relationship. The copy process has been started but the
two virtual disks are not yet synchronized.

Copy Services
The services that enable you to copy virtual disks (VDisks): FlashCopy,
Metro, and Global Mirror.

counterpart SAN
A nonredundant portion of a redundant storage area network (SAN). A
counterpart SAN provides all the connectivity of the redundant SAN but
without the redundancy. Each counterpart SANs provides an alternate path
for each SAN-attached device. See also redundant SAN.

cross-volume consistency
In SAN Volume Controller, a consistency group property that guarantees
consistency between virtual disks when an application issues dependent
write operations that span multiple virtual disks.

D

data migration
The movement of data from one physical location to another without
disrupting I/O operations.
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degraded
Pertaining to a valid configuration that has suffered a failure but continues
to be supported and legal. Typically, a repair action can be performed on a
degraded configuration to restore it to a valid configuration.

dense wavelength division multiplexing (DWDM)
A technology that places many optical signals onto one single-mode fiber
using slightly different optical frequencies. DWDM enables many data
streams to be transferred in parallel.

dependent write operations
A set of write operations that must be applied in the correct order to
maintain cross-volume consistency.

destage
A write command initiated by the cache to flush data to disk storage.

device
In the CIM Agent, the storage server that processes and hosts client
application requests.

IBM definition: A piece of equipment that is used with the computer and
does not generally interact directly with the system, but is controlled by a
controller.

HP definition: In its physical form, a magnetic disk that can be attached to a
SCSI bus. The term is also used to indicate a physical device that has been
made part of a controller configuration; that is, a physical device that is
known to the controller. Units (virtual disks) can be created from devices
after the devices have been made known to the controller.

device provider
A device-specific handler that serves as a plug-in for the Common
Information Model (CIM); that is, the CIM object manager (CIMOM) uses
the handler to interface with the device.

directed maintenance procedures
The set of maintenance procedures that can be run for a cluster. These
procedures are run from within the SAN Volume Controller application and
are documented in the IBM System Storage SAN Volume Controller
Troubleshooting Guide.

disconnected
In a Metro or Global Mirror relationship, pertains to two clusters when they
cannot communicate.

discovery
The automatic detection of a network topology change, for example, new
and deleted nodes or links.

disk controller
A device that coordinates and controls the operation of one or more disk
drives and synchronizes the operation of the drives with the operation of the
system as a whole. Disk controllers provide the storage that the cluster
detects as managed disks (MDisks).

disk drive
A disk-based, nonvolatile, storage medium.
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disk zone
A zone defined in the storage area network (SAN) fabric in which the SAN
Volume Controller can detect and address the logical units that the disk
controllers present.

Distributed Management Task Force (DMTF)
An organization that defines standards for the management of distributed
systems. See also Common Information Model.

DMP See directed maintenance procedures.
DMTF See Distributed Management Task Force.

domain name server
In the Internet suite of protocols, a server program that supplies
name-to-address conversion by mapping domain names to IP addresses.

DRAM See dynamic random access memory.

DWDM
See dense wavelength division multiplexing.

dynamic random access memory (DRAM)
A storage in which the cells require repetitive application of control signals
to retain stored data.

E
EC See engineering change.
EIA See Electronic Industries Alliance.

Electronic Industries Alliance (EIA)
An alliance of four trade associations: The Electronic Components,
Assemblies & Materials Association (ECA); the Government Electronics and
Information Technology Association (GEIA); the JEDEC Solid State
Technology Association (JEDEC); and the Telecommunications Industry
Association (TIA). Prior to 1998, EIA was the Electronic Industries
Association and the group dates back to 1924.

empty In a Global Mirror relationship, a status condition that exists when the
consistency group contains no relationships.

engineering change (EC)
A correction for a defect of hardware or software that is applied to a
product.

error code
A value that identifies an error condition.

ESS See IBM TotalStorage Enterprise Storage Server®.

exclude
To remove a managed disk (MDisk) from a cluster because of certain error
conditions.

excluded
In SAN Volume Controller, the status of a managed disk that the cluster has
removed from use after repeated access errors.

extent A unit of data that manages the mapping of data between managed disks
and virtual disks.
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fabric In fibre-channel technology, a routing structure, such as a switch, that
receives addressed information and routes it to the appropriate destination.
A fabric can consist of more than one switch. When multiple fibre-channel
switches are interconnected, they are described as cascading. See also
cascading.

fabric port (F_port)
A port that is part of a fibre-channel fabric. An F_port on a fibre-channel
fabric connects to the node port (N_port) on a node.

failover
In SAN Volume Controller, the function that occurs when one redundant
part of the system takes over the workload of another part of the system
that has failed.

FCIP See Fibre Channel over IP.

fibre channel
A technology for transmitting data between computer devices at a data rate
of up to 4 Gbps. It is especially suited for attaching computer servers to
shared storage devices and for interconnecting storage controllers and
drives.

fibre-channel extender
A device that extends a fibre-channel link over a greater distance than is
supported by the standard, usually a number of miles or kilometers.
Devices must be deployed in pairs at each end of a link.

Fibre Channel over IP (FCIP)
A network storage technology that combines the features of the Fibre
Channel Protocol and the Internet Protocol (IP) to connect distributed SANs
over large distances.

Fibre Channel Protocol (FCP)
A protocol that is used in fibre-channel communications with five layers that
define how fibre-channel ports interact through their physical links to
communicate with other ports.

field replaceable unit (FRU)
An assembly that is replaced in its entirety when any one of its components
fails. An IBM service representative performs the replacement. In some
cases, a field replaceable unit might contain other field replaceable units.

FlashCopy mapping
A relationship between two virtual disks.

FlashCopy relationship
See FlashCopy mapping.

FlashCopy service
In SAN Volume Controller, a copy service that duplicates the contents of a
source virtual disk (VDisk) to a target VDisk. In the process, the original
contents of the target VDisk are lost. See also point-in-time copy.

F_port
See fabric port.

FRU See field replaceable unit.
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G

gateway
An entity that operates above the link layer and translates, when required,
the interface and protocol used by one network into those used by another
distinct network.

GB See gigabyte.
GBIC See gigabit interface converter.

gigabit interface converter (GBIC)
An interface module that converts the light stream from a fibre-channel
cable into electronic signals for use by the network interface card.

gigabyte (GB)
In decimal notation, 1 073 741 824 bytes.

Global Mirror
An asynchronous copy service that enables host data on a particular source
virtual disk (VDisk) to be copied to the target VDisk that is designated in the
relationship.

grain In a FlashCopy bitmap, the unit of data represented by a single bit.

graphical user interface (GUI)
A type of computer interface that presents a visual metaphor of a real-world
scene, often of a desktop, by combining high-resolution graphics, pointing
devices, menu bars and other menus, overlapping windows, icons and the
object-action relationship.

GUI  See graphical user interface.

H

hardcoded
Pertaining to software instructions that are statically encoded and not
intended to be altered.

HBA See host bus adapter.
HLUN See virtual disk.

hop One segment of a transmission path between adjacent nodes in a routed
network.

host An open-systems computer that is connected to the SAN Volume Controller
through a fibre-channel interface.

host bus adapter (HBA)
In SAN Volume Controller, an interface card that connects a host bus, such
as a peripheral component interconnect (PCI) bus, to the storage area
network.

host ID
In SAN Volume Controller, a numeric identifier assigned to a group of host
fibre-channel ports for the purpose of logical unit number (LUN) mapping.
For each host ID, there is a separate mapping of Small Computer System
Interface (SCSI) IDs to virtual disks (VDisks).

host zone
A zone defined in the storage area network (SAN) fabric in which the hosts
can address the SAN Volume Controllers.

hub A fibre-channel device that connects nodes into a logical loop by using a
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physical star topology. Hubs will automatically recognize an active node and
insert the node into the loop. A node that fails or is powered off is
automatically removed from the loop.

A communications infrastructure device to which nodes on a multi-point bus
or loop are physically connected. Commonly used in Ethernet and
fibre-channel networks to improve the manageability of physical cables.
Hubs maintain the logical loop topology of the network of which they are a
part, while creating a “hub and spoke” physical star layout. Unlike switches,
hubs do not aggregate bandwidth. Hubs typically support the addition or
removal of nodes from the bus while it is operating. (S) Contrast with
switch.

IBM System Storage Productivity Center (SSPC)
An integrated hardware and software solution that provides a single point of
entry for managing SAN Volume Controller clusters, IBM System Storage
DS8000™ systems, and other components of a data storage infrastructure.

IBM TotalStorage Enterprise Storage Server (ESS)
An IBM product that provides an intelligent disk-storage system across an
enterprise.

ID See identifier.

identifier (ID)
A sequence of bits or characters that identifies a user, program device, or
system to another user, program device, or system.

idle In a FlashCopy mapping, the state that occurs when the source and target
virtual disks (VDisks) act as independent VDisks even if a mapping exists
between the two. Read and write caching is enabled for both the source
and the target.

idling The status of a pair of virtual disks (VDisks) that have a defined copy
relationship for which no copy activity has yet been started.

In a Metro or Global Mirror relationship, the state that indicates that the
master virtual disks (VDisks) and auxiliary VDisks are operating in the
primary role. Consequently, both VDisks are accessible for write 1/0
operations.

idling-disconnected
In a Global Mirror relationship, the state that occurs when the virtual disks
(VDisks) in this half of the consistency group are all operating in the primary
role and can accept read or write 1/O operations.

illegal configuration
A configuration that will not operate and will generate an error code to
indicate the cause of the problem.

image mode
An access mode that establishes a one-to-one mapping of extents in the
managed disk (MDisk) with the extents in the virtual disk (VDisk). See also
managed space mode and unconfigured mode.

image VDisk
A virtual disk (VDisk) in which there is a direct block-for-block translation
from the managed disk (MDisk) to the VDisk.

IML See initial microcode load.
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inconsistent
In a Metro or Global Mirror relationship, pertaining to a secondary virtual
disk (VDisk) that is being synchronized with the primary VDisk.

inconsistent-copying
In a Global Mirror relationship, the state that occurs when the primary
virtual disk (VDisk) is accessible for read and write input/output (I/O)
operations, but the secondary VDisk is not accessible for either. This state
occurs after a start command is issued to a consistency group that is in the
inconsistent-stopped state. This state also occurs when a start command is
issued, with the force option, to a consistency group that is in the idling or
consistent-stopped state.

inconsistent-disconnected
In a Global Mirror relationship, a state that occurs when the virtual disks
(VDisks) in the half of the consistency group that is operating in the
secondary role are not accessible for either read or write I/O operations.

inconsistent-stopped
In a Global Mirror relationship, the state that occurs when the primary
virtual disk (VDisk) is accessible for read and write input/output (I/O)
operations, but the secondary VDisk is not accessible for either read or
write 1/0O operations.

indication
An object representation of an event.

initial microcode load (IML)
In SAN Volume Controller, the process by which the run-time code and data
for a node are loaded into memory and initialized.

initiator
The system component that originates an I/O command over an 1/O bus or
network. I/O adapters, network interface cards, and intelligent controller
device /O bus control ASICs are typical initiators. (S) See also logical unit
number.

input/output (I/0)
Pertaining to a functional unit or communication path involved in an input
process, an output process, or both, concurrently or not, and to the data
involved in such a process.

instance
An individual object that is a member of some class. In object-oriented
programming, an object is created by instantiating a class.

integrity
The ability of a system to either return only correct data or respond that it
cannot return correct data.

Internet Protocol (IP)
In the Internet suite of protocols, a connectionless protocol that routes data
through a network or interconnected networks and acts as an intermediary
between the higher protocol layers and the physical network. IPv4 is the
dominant network layer protocol on the Internet, and IPv6 is designated as
its successor. IPv6 provides a much larger address space, which enables
greater flexibility in assigning addresses and simplifies routing and
renumbering.
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interswitch link (ISL)
The physical connection that carries a protocol for interconnecting multiple
routers and switches in a storage area network.

/0 See input/output.

I/0 group
A collection of virtual disks (VDisks) and node relationships that present a
common interface to host systems.

I/0O throttling rate
The maximum rate at which an 1/O transaction is accepted for this virtual

disk (VDisk).
IP See Internet Protocol.
IP address

The unique 32-bit address that specifies the location of each device or
workstation in the Internet. For example, 9.67.97.103 is an IP address.

ISL See interswitch link.

ISL hop
A hop on an interswitch link (ISL). Considering all pairs of node ports
(N-ports) in a fabric and measuring distance only in terms of interswitch
links (ISLs) in the fabric, the number of ISLs traversed is the number of ISL
hops on the shortest route between the pair of nodes that are farthest apart
in the fabric.

J

JBOD (just a bunch of disks)
IBM definition: See non-RAID.

HP definition: A group of single-device logical units not configured into any
other container type.

L
LBA  See logical block address.

least recently used (LRU)
An algorithm used to identify and make available the cache space that
contains the least-recently used data.

line card
See blade.

local fabric
In SAN Volume Controller, those storage area network (SAN) components
(such as switches and cables) that connect the components (nodes, hosts,
switches) of the local cluster together.

local/remote fabric interconnect
The storage area network (SAN) components that are used to connect the
local and remote fabrics together.

logical block address (LBA)
The block number on a disk.

logical unit (LU)
An entity to which Small Computer System Interface (SCSI) commands are
addressed, such as a virtual disk (VDisk) or managed disk (MDisk).
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logical unit number (LUN)
The SCSI identifier of a logical unit within a target. (S)

longitudinal redundancy check (LRC)
A method of error checking during data transfer that involves checking

parity.
LRC See longitudinal redundancy check.
LRU See least recently used.
LU See logical unit.
LUN  See logical unit number.

LUN masking
A process that allows or prevents 1/O to the disk drives through the
host-bus-adapter (HBA) device or operating-system device driver.

M

managed disk (MDisk)
A Small Computer System Interface (SCSI) logical unit that a redundant
array of independent disks (RAID) controller provides and a cluster
manages. The MDisk is not visible to host systems on the storage area
network (SAN).

managed disk group
A collection of managed disks (MDisks) that, as a unit, contain all the data
for a specified set of virtual disks (VDisks).

Managed Object Format (MOF)
A language for defining Common Information Model (CIM) schemas.

managed space mode
An access mode that enables virtualization functions to be performed. See
also image mode and unconfigured mode.

Management Information Base (MIB)
Simple Network Management Protocol (SNMP) units of managed
information that specifically describe an aspect of a system, such as the
system name, hardware number, or communications configuration. A
collection of related MIB objects is defined as a MIB.

mapping
See FlashCopy mapping.

master console
A single point from which to manage the IBM System Storage SAN Volume
Controller. For SAN Volume Controller version 4.2.1 and earlier, the master
console was purchased either as software that was installed and configured
on a server or as a hardware platform with preinstalled operating system
and master console software. See IBM System Storage Productivity Center.

master virtual disk
The virtual disk (VDisk) that contains a production copy of the data and that
an application accesses. See also auxiliary virtual disk.

MB See megabyte.
MDisk See managed disk.

megabyte (MB)

In decimal notation, 1 048 576 bytes.
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mesh configuration
A network that contains a number of small SAN switches configured to
create a larger switched network. With this configuration, four or more
switches are connected together in a loop with some of the paths short
circuiting the loop. An example of this configuration is to have four switches
connected together in a loop with ISLs for one of the diagonals.

method
A way to implement a function on a class.

Metro Mirror
A synchronous copy service that enables host data on a particular source
virtual disk (VDisk) to be copied to the target VDisk that is designated in the
relationship.

MIB  See Management Information Base.

migration
See data migration.

mirrored virtual disk
A virtual disk (VDisk) with two VDisk copies.

mirrorset
IBM definition: See RAID-1.

HP definition: A RAID storageset of two or more physical disks that maintain
a complete and independent copy of the data from the virtual disk. This
type of storageset has the advantage of being highly reliable and extremely
tolerant of device failure. Raid level 1 storagesets are referred to as

mirrorsets.

MOF See Managed Object Format (MOF).

N

namespace
The scope within which a Common Information Model (CIM) schema
applies.

node One SAN Volume Controller. Each node provides virtualization, cache, and
Copy Services to the storage area network (SAN).

node name
A name identifier associated with a node. (SNIA)

node port (N_port)
A port that connects a node to a fabric or to another node. N_ports connect
to fabric ports (F_ports) or to other N_ports of other nodes. N_ports handle
creation, detection, and flow of message units to and from the connected
systems. N_ports are end points in point-to-point links.

node rescue
In SAN Volume Controller, the process by which a node that has no valid
software installed on its hard disk drive can copy the software from another
node connected to the same fibre-channel fabric.

non-RAID
Disks that are not in a redundant array of independent disks (RAID). HP
definition: See JBOD.

N_port
See node port.
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object In object-oriented design or programming, a concrete realization of a class
that consists of data and the operations associated with that data.

object model
A representation, such as a diagram, of objects in a given system. Using
symbols similar to standard flowchart symbols, an object model depicts the
classes the objects belong to, their associations with each other, the
attributes that make them unique, and the operations that the objects can
perform and that can be performed on them.

object name
An object that consists of a namespace path and a model path. The
namespace path provides access to the Common Information Model (CIM)
implementation managed by the CIM Agent, and the model path provides
navigation within the implementation.

object path
An object that consists of a namespace path and a model path. The
namespace path provides access to the Common Information Model (CIM)
implementation managed by the CIM Agent, and the model path provides
navigation within the implementation.

offline Pertaining to the operation of a functional unit or device that is not under
the continual control of the system or of a host.

online Pertaining to the operation of a functional unit or device that is under the
continual control of the system or of a host.

operating set
In SAN Volume Controller, the set of nodes that are operating together to
deliver storage services.

overallocated volume
See space-efficient virtual disk.

oversubscription
The ratio of the sum of the traffic that is on the initiator N-node connections
to the traffic that is on the most heavily loaded interswitch links (ISLs),
where more than one ISL is connected in parallel between these switches.
This definition assumes a symmetrical network and a specific workload that
is applied equally from all initiators and sent equally to all targets. See also
symmetrical network.

P

partition
IBM definition: A logical division of storage on a fixed disk.

HP definition: A logical division of a container represented to the host as a
logical unit.

partner node
The other node that is in the I/O group to which this node belongs.

partnership
In Metro or Global Mirror operations, the relationship between two clusters.
In a cluster partnership, one cluster is defined as the local cluster and the
other cluster as the remote cluster.
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paused
In SAN Volume Controller, the process by which the cache component
quiesces all ongoing 1/O activity below the cache layer.

pend To cause to wait for an event.

petabyte (PB)
In decimal notation, 1 125 899 906 842 624 bytes.

PDU See power distribution unit.

physical disk licensing
A type of licensing that grants you the use of a number of physical disks for
virtualization. You can also license the use of the Metro Mirror and Global
Mirror feature, the use of the FlashCopy feature, or both of these features.

PLUN See managed disk.

point-in-time copy
The instantaneous copy that the FlashCopy service makes of the source
virtual disk (VDisk). In some contexts, this copy is known as a T, copy.

port  The physical entity within a host, SAN Volume Controller, or disk controller
system that performs the data communication (transmitting and receiving)
over the fibre channel.

port ID
An identifier associated with a port.

power distribution unit (PDU)
A device that distributes electrical power to multiple devices in the rack. It
typically is rack-mounted and provides circuit breakers and transient voltage
suppression.

power-on self-test
A diagnostic test that servers or computers run when they are turned on.

prepared
In a Global Mirror relationship, the state that occurs when the mapping is
ready to start. While in this state, the target virtual disk (VDisk) is offline.

preparing
In a Global Mirror relationship, the state that occurs when any changed
write data for the source virtual disk (VDisk) is flushed from the cache. Any
read or write data for the target VDisk is discarded from the cache.

primary virtual disk
In a Metro or Global Mirror relationship, the target of write operations issued
by the host application.

property
In the Common Information Model (CIM), an attribute that is used to
characterize instances of a class.

PuTTY
A client program that allows you to run remote sessions on your computer
through specific network protocols, such as SSH, Telnet, and Rlogin.

Q

qualifier
A value that provides additional information about a class, association,
indication, method, method parameter, instance, property, or reference.
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quorum
A set of nodes that operates as a cluster. Each node has a connection to
every other node in the cluster. If a connection failure causes the cluster to
split into two or more groups of nodes that have full connection within the
group, the quorum is the group that is selected to operate as the cluster.
Typically, this is the larger group of nodes, but the quorum disk serves as a
tiebreaker if the groups are the same size.

queue depth
The number of 1/0O operations that can be run in parallel on a device.

quorum disk
A managed disk (MDisk) that contains a reserved area that is used
exclusively for cluster management. The quorum disk is accessed in the
event that it is necessary to determine which half of the cluster continues to
read and write data.

quorum index
A number that can be either: 0, 1 or 2

R
rack A free-standing framework that holds the devices and card enclosure.
RAID See redundant array of independent disks.

RAID 0
IBM definition: RAID 0 allows a number of disk drives to be combined and
presented as one large disk. RAID 0 does not provide any data
redundancy. If one drive fails, all data is lost.

HP definition: A RAID storageset that stripes data across an array of disk
drives. A single logical disk spans multiple physical disks, allowing parallel
data processing for increased I/O performance. While the performance
characteristics of RAID level 0 is excellent, this RAID level is the only one
that does not provide redundancy. Raid level 0 storagesets are referred to
as stripesets.

RAID 1
SNIA dictionary definition: A form of storage array in which two or more
identical copies of data are maintained on separate media. (S)

IBM definition: A form of storage array in which two or more identical copies
of data are maintained on separate media. Also known as mirrorset.

HP definition: See mirrorset.

RAID 5
SNIA definition: A form of parity RAID in which the disks operate
independently, the data strip size is no smaller than the exported block size,
and parity check data is distributed across the array’s disks. (S)

IBM definition: See the SNIA definition.

HP definition: A specially developed RAID storageset that stripes data and
parity across three or more members in a disk array. A RAIDset combines
the best characteristics of RAID level 3 and RAID level 5. A RAIDset is the
best choice for most applications with small to medium I/O requests, unless
the application is write intensive. A RAIDset is sometimes called parity
RAID. RAID level 3/5 storagesets are referred to as RAIDsets.

RAID 10
A type of RAID that optimizes high performance while maintaining fault
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tolerance for up to two failed disk drives by striping volume data across
several disk drives and mirroring the first set of disk drives on an identical
set.

real capacity
The amount of storage that is allocated to a virtual disk copy from a
managed disk group.

redundant ac-power switch
A device that provides input power redundancy by attaching a SAN Volume
Controller to two independent power sources. If the main source becomes
unavailable, the redundant ac-power switch automatically provides power
from a secondary (backup) source. When power is restored, the redundant
ac-power switch automatically changes back to the main power source.

redundant array of independent disks (RAID)
A collection of two or more disk drives that present the image of a single
disk drive to the system. In the event of a single device failure, the data can
be read or regenerated from the other disk drives in the array.

redundant SAN
A storage area network (SAN) configuration in which any one single
component might fail, but connectivity between the devices within the SAN
is maintained, possibly with degraded performance. This configuration is
normally achieved by splitting the SAN into two, independent, counterpart
SANSs. See also counterpart SAN.

reference
A pointer to another instance that defines the role and scope of an object in
an association.

rejected
A status condition that describes a node that the cluster software has
removed from the working set of nodes in the cluster.

relationship
In Metro or Global Mirror, the association between a master virtual disk
(VDisk) and an auxiliary VDisk. These VDisks also have the attributes of a
primary or secondary VDisk. See also auxiliary virtual disk, master virtual
disk, primary virtual disk, and secondary virtual disk.

reliability

The ability of a system to continue to return data even if a component fails.
remote fabric

In Global Mirror, the storage area network (SAN) components (switches and

cables) that connect the components (nodes, hosts, and switches) of the
remote cluster.

roles Authorization is based on roles that map to the administrator and service
roles in an installation. The switch translates these roles into SAN Volume
Controller administrator and service user IDs when a connection is made to
the node for the SAN Volume Controller.

S

SAN See storage area network.

SAN Volume Controller fibre-channel port fan in
The number of hosts that can see any one SAN Volume Controller port.

SATA See Serial Advanced Technology Attachment.
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schema
A group of object classes defined for and applicable to a single namespace.
Within the CIM Agent, the supported schemas are the ones that are loaded
through the managed object format (MOF).

SCSI See Small Computer Systems Interface.

SCSI back-end layer
The layer in a Small Computer Systems Interface (SCSI) network that
performs the following functions: controls access to individual disk controller
systems that are managed by the cluster; receives requests from the
virtualization layer, processes them, and sends them to managed disks;
addresses SCSI-3 commands to the disk controller systems on the storage
area network (SAN).

SCSI front-end layer
The layer in a Small Computer Systems Interface (SCSI) network that
receives 1/0 commands sent from hosts and provides the SCSI-3 interface
to hosts. SCSI logical unit numbers (LUNs) are mapped to virtual disks
(VDisks) in this layer as well. Thus, the layer converts SCSI read and write
commands that are addressed to LUNs into commands that are addressed
to specific VDisks.

SDD See subsystem device driver (SDD).

secondary virtual disk
In Metro or Global Mirror, the virtual disk (VDisk) in a relationship that
contains a copy of data written by the host application to the primary VDisk.

Secure Shell (SSH)
A program to log in to another computer over a network, to run commands
in a remote machine, and to move files from one machine to another.

Secure Sockets Layer (SSL)
A security protocol that provides communication privacy. With SSL,
client/server applications can communicate in a way that is designed to
prevent eavesdropping, tampering, and message forgery.

sequential VDisk
A virtual disk that uses extents from a single managed disk.

Serial Advanced Technology Attachment (SATA)
The evolution of the ATA interface from a parallel bus to serial connection
architecture. (S)

Serial ATA
See Serial Advanced Technology Attachment.

server In a network, the hardware or software that provides facilities to other
stations; for example, a file server, a printer server, a mail server. The
station making the request of the server is usually called the client.

Service Location Protocol (SLP)
In the Internet suite of protocols, a protocol that identifies and uses network
hosts without having to designate a specific network host name.

fibre-channel SFP connector
See small form-factor pluggable connector.

Simple Mail Transfer Protocol (SMTP)
An Internet application protocol for transferring mail among users of the
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Internet. SMTP specifies the mail exchange sequences and message
format. It assumes that the Transmission Control Protocol (TCP) is the
underlying protocol.

Simple Network Management Protocol (SNMP)
In the Internet suite of protocols, a network management protocol that is
used to monitor routers and attached networks. SNMP is an
application-layer protocol. Information on devices managed is defined and
stored in the application’s Management Information Base (MIB).

SLP  See Service Location Protocol.

Small Computer System Interface (SCSI)
A standard hardware interface that enables a variety of peripheral devices
to communicate with one another.

small form-factor pluggable (SFP) connector
A compact optical transceiver that provides the optical interface to a
fibre-channel cable.

SMI-S See Storage Management Initiative Specification.
SMTP See Simple Mail Transfer Protocol.

SNIA See Storage Networking Industry Association.
SNMP See Simple Network Management Protocol.

space-efficient VDisk
See space-efficient virtual disk.

space-efficient virtual disk
A virtual disk that has different virtual capacities and real capacities.

SSH  See Secure Shell.
SSPC See IBM System Storage Productivity Center (SSPC).
SSL  See Secure Sockets Layer.

stand-alone relationship
In FlashCopy, Metro Mirror, and Global Mirror, relationships that do not
belong to a consistency group and that have a null consistency group
attribute.

stop A configuration command that is used to stop the activity for all copy
relationships in a consistency group.

stopped
The status of a pair of virtual disks (VDisks) that have a copy relationship
that the user has temporarily broken because of a problem.

storage area network (SAN)
A network whose primary purpose is the transfer of data between computer
systems and storage elements and among storage elements. A SAN
consists of a communication infrastructure, which provides physical
connections, and a management layer, which organizes the connections,
storage elements, and computer systems so that data transfer is secure
and robust. (S)

Storage Management Initiative Specification (SMI-S)
A design specification developed by the Storage Networking Industry
Association (SNIA) that specifies a secure and reliable interface that allows
storage management systems to identify, classify, monitor, and control
physical and logical resources in a storage area network. The interface is
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intended as a solution that integrates the various devices to be managed in
a storage area network (SAN) and the tools used to manage them.

Storage Networking Industry Association (SNIA)
An association of producers and consumers of storage networking products
whose goal is to further storage networking technology and applications.
See www.snia.org.

striped
Pertains to a virtual disk (VDisk) that is created from multiple managed
disks (MDisks) that are in the MDisk group. Extents are allocated on the
MDisks in the order specified.

stripeset
See RAID 0.

subsystem device driver (SDD)
An IBM pseudo device driver designed to support the multipath
configuration environments in IBM products.

superuser authority
Can issue any command-line interface (CLI) command. A superuser can
view and work with the following panels: View users, Add cluster, Remove
cluster, Add users, and Modify users. Only one Superuser role is available.

suspended
The status of a pair of virtual disks (VDisks) that have a copy relationship
that has been temporarily broken because of a problem.

switch
A network infrastructure component to which multiple nodes attach. Unlike
hubs, switches typically have internal bandwidth that is a multiple of link
bandwidth, and the ability to rapidly switch node connections from one to
another. A typical switch can accommodate several simultaneous full link
bandwidth transmissions between different pairs of nodes. (S) Contrast with
hub.

symmetrical network
A network in which all the initiators are connected at the same level and all
the controllers are connected at the same level.

symmetric virtualization
A virtualization technique in which the physical storage in the form of
Redundant Array of Independent Disks (RAID) is split into smaller chunks of
storage known as extents. These extents are then concatenated, using
various policies, to make virtual disks (VDisks). See also asymmetric
virtualization.

synchronized
In Metro or Global Mirror, the status condition that exists when both virtual
disks (VDisks) of a pair that has a copy relationship contain the same data.

system
A functional unit, consisting of one or more computers and associated
software, that uses common storage for all or part of a program and also
for all or part of the data necessary for the execution of the program. A
computer system can be a stand-alone unit, or it can consist of multiple
connected units.
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terabyte
In decimal notation, 1 099 511 628 000 bytes.

thinly provisioned volume
See space-efficient virtual disk.

topology
The logical layout of the components of a computer system or network and
their interconnections. Topology deals with questions of what components
are directly connected to other components from the standpoint of being
able to communicate. It does not deal with questions of physical location of
components or interconnecting cables. (S)

trigger
To initiate or reinitiate copying between a pair of virtual disks (VDisks) that
have a copy relationship.

U
uUID See unique identifier.

unconfigured mode
A mode in which 1/0O operations cannot be performed. See also image
mode and managed space mode.

uninterruptible power supply
A device that is connected between a computer and its power source that
protects the computer against blackouts, brownouts, and power surges. The
uninterruptible power supply contains a power sensor to monitor the supply
and a battery to provide power until an orderly shutdown of the system can
be performed.

unique identifier (UID)
An identifier that is assigned to storage system logical units when they are
created. It is used to identify the logical unit regardless of the logical unit
number (LUN), status of the logical unit, or whether alternate paths exist to
the same device. Typically, a UID is only used once.

unmanaged
An access mode that pertains to a managed disk (MDisk) that is not used
by the cluster.

\'}

valid configuration
A configuration that is supported.

VDisk See virtual disk (VDisk).

VDisk copy
See virtual disk copy.

virtual capacity
The amount of storage that is available to a server on a virtual disk (VDisk)
copy. In a space-efficient virtual disk, the virtual capacity can be different
from the real capacity. In a standard virtual disk, the virtual capacity and
real capacity are the same.

virtual disk copy
A physical copy of the data that is stored on a virtual disk (VDisk). Mirrored
VDisks have two such copies. Nonmirrored VDisks have one copy.
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virtual disk (VDisk)
A device that host systems in a storage area network (SAN) recognize as a
Small Computer System Interface (SCSI) disk.

virtualization
In the storage industry, a concept in which a pool of storage is created that
contains several disk subsystems. The subsystems can be from various
vendors. The pool can be split into virtual disks that are visible to the host
systems that use them.

virtualized storage
Physical storage that has virtualization techniques applied to it by a
virtualization engine.

virtual storage area network (VSAN)
A fabric within the SAN.

vital product data (VPD)
Information that uniquely defines system, hardware, software, and
microcode elements of a processing system.

VLUN See managed disk.
VPD See vital product data.

VSAN See virtual storage area network.

w

WBEM
See Web-Based Enterprise Management.

Web-Based Enterprise Management (WBEM)
A tiered, enterprise-management architecture that was developed by the
Distributed Management Task Force (DMTF). This architecture provides the
management design framework that consists of devices, device providers,
the object manager, and the messaging protocol for the communication
between client applications and the object manager.

worldwide node name (WWNN)
An identifier for an object that is globally unique. WWNNSs are used by Fibre
Channel and other standards.

worldwide port name (WWPN)
A unique 64-bit identifier that is associated with a fibre-channel adapter
port. The WWPN is assigned in an implementation- and
protocol-independent manner.

WWNN
See worldwide node name.

WWPN
See worldwide port name.

z

zoning
In fibre-channel environments, the grouping of multiple ports to form a
virtual, private, storage network. Ports that are members of a zone can
communicate with each other, but are isolated from ports in other zones.
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